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Key points

This document is intended to serve as a quick introduction to the notion of
geo-webservices. It was originally written for students at the International In-
stitute for Geo-Information Science and Earth Observation (ITC) that are fairly
familiar with spatial data and GIS. It is based on the teaching materials
(slides, exercises) for various modules on WebGIS, Webmapping, Spatial
Data Infrastructures and the like, developed by Rob Lemmens, Andreas
Wiytzisk and Barend Kobben.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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B.1. From monolithic to distributed GIS architectures

Interoperable geowebservices are the latest in a long line of software for hand-
ling geographic, or spatial, information. In 1962 Roger Tomlinson built the
Canada Geographic Information System to determine the land capability for
rural Canada by mapping information about soils, agriculture, land use, etc. He
coined the term GIS for software that is used to gather, visualize and analyse
geo-information. Tomlinsons GIS software was running on a large mainframe
computer and its architecture was what we call monolithic, with the presenta-
tion logic, application logic, and data management layers combined in one soft-
ware tier. This might still be the typical design for simple desktop applications,
but nowadays larger GISs, like other software systems, have their logical layers
separated. Separate logical layers, a depicted in Figure B.1 improve the inter-
operability between Geographic Information Systems.

One or more database layers take care of the data storage and retrieval, appli-
cation layers are used to analyse the information, a mapping engine turns the
information into maps, and separate client software gives the actual users ac-
cess to all of this. The main advantage of such a setup is the flexibility: the
different parts can be distributed over various computers and thus can easily
be scaled, that is, adopted to changing conditions, such as an increasing num-
ber of users. Because the client software is separated from the application
logic, the same backend can serve different client platforms (e.g. PCs, PDAs
and mobile phones). Equally the data being used in the analysis part can come
from various different information sources, from various providers, even from
different places on the globe.

User interfacs

Geo-processing tools

Database managemsnt

!

Database

Fig. B.1: A typical setup of lay-
ersina GIS.
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B.2. Interoperable webservices

Probably the bestknown example of such a distributed system approach is the
World Wide Web. The WW\W consist of many distributed servers that are re-
sponding to individual requests of a sheer endless amount of distributed
clients. This kind of system is only possible when the different components are
guaranteed to work together, because they are interoperable.

The International Standards Organisation (ISO) defines interoperability as:
“The capability to communicate, execute programs, or transfer data among var-
ious functional units in a manner that requires the user to have little or no
knowledge of the unique characteristics of those units.” Interoperability in com-
puter systems, as shown in Figure B.2, means in the first place that the sys-
tems are able to transfer data seamlessly.

This can be achieved by having the data encoded in a standardized, platform
and application independent manner. Nowadays,the popular encoding scheme
used for that purpose is the eXtensible Markup Language (XML).

B.2.1. XML: eXtensible Markup Language

The eXtensible Markup Language (XML) is a computer language that defines a
set of rules for encoding documents in a format that is both human-readable
and machine-readable. The design goals of XML emphasize simplicity, gener-
ality, and usability over the Internet. It is a textual data format and widely used
for the representation of arbitrary data structures, for example in web services
[wikipedia.org].

The structure of XML uses a strict separation of content from presentation.
XML is “self descriptive”, it provides a way to encode both structure and con-

System 4 System B

Usar interfoce

User interfece I

Geo-processing tonks Geo-processing tonks

+ | ) |
Datahase managemsant Datahase managemant
Database Database

Fig. B.2: Interoperable Geographic Information Systems.
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Fig. B.3: An example of XML.

tent of data. In any XML-language, the XML standard just sets the syntax, and
an XML schema is needed to explain what the XML means. One can compare
it to a set of languages that share exactly the same grammar. The big advan-
tage is that only translation of individual words is needed to translate one lan-
guage to another...

B.2.2. Webservices

Interoperability also means that two information systems should be able to ac-
cess distributed functionality in a seamless manner. This would for example
mean that one Geographic Information System could use the geo-processing
tools of another GIS. For that to work regardless of operating system, computer
platform or software used, we have to specify and set up an infrastructure of in-
teroperable software services. Service-oriented software differs from traditional
software in that it fully encapsulates its own functionalities and makes it acces-
sible only via well specified and standardised interfaces. These interfaces pub-
licise the methods that a software component implements, and its calling con-
ventions. In other words, you do not know, nor have to know, how the service
actually works, only what input it can receive and what output you can expect
back. There are many ways of setting up such Service Oriented Architectures
(or SOA’s), but by far the most used distribution platform is the WMWW and the
services implemented on that are logically called webservices.

Webservices are components that can be described, published, located and in-
voked over the Internet. They are defined as loosely coupled components that
communicate via XML-based interfaces.

Loosely coupled means that they are independent of computer platform and
can be exchanged by similar components, e.g., when one service fails or is too
busy, the system can find a similar service elsewhere on the Web. The XML-
based interfaces are human readable and selfdescribing, which allows for auto-
mated discovery of their functionality.

A simple example of such a Webservice is a currency convertor, for example
the one at http://www.webservicex.net/. If an application (such as the Demo
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form on the webpage) is used to send a request to this service formatted as a
standardized XML message

<FromCurrency>USD</FromCurrency>
<ToCurrency>EUR</ToCurrency>

the service returns a standardized XML response:

<double>0.92635</double>

If webservices have spatial functionality, for example if they use geographic
data, can output maps or find routes, we call them geowebservices.

B.3. Geowebservices

There are many such geowebservices available, the best-know proponent of it
probably is Google Maps, and other examples are Bing Maps and Yahoo Local
Maps. These examples can be used by anybody, as their interfaces are pub-
licly available, but they are still proprietary in the sense that they are defined,
developed and owned by commercial companies. Alternatively, Open Stan-
dards are created in an open, participatory process, where everyone interested
can influence the standard.

The resulting specifications are non-proprietary, that is, owned in common.
That means free rights of distribution (no royalty or other fee) and a free, public,
and open access to interface specifications that are also technology neutral.
There is a set of such well defined Open Standards for geowebservices: the
Open Web Services (OWS) of the Open Geospatial Consortium (OGC).

The OGC was founded in 1994 as a not-for-profit, international voluntary con-
sensus standards organization that develops Open Standards for geospatial
and location based services. Their core mission is to deliver interface specifica-
tions that are openly available for global use. The Open Web Services specifi-
cations are the basis of many high-profile projects (e.g. the European Commu-
nity INSPIRE initiative).

B.3.1. Open Web Services specifications (OWS)

There are OWS specifications for most parts of the spatial data storage, analy-
sis and delivery process:

« for geographic data encoding: the complete and complicated Geographic
Markup Language (GML), and the simpler, more limited Keyhole Markup
Language (KML);

» for spatial data delivery: the Web Coverage Service (WCS) and Web Fea-
ture Service (WFS), for querying and retrieving raster and vector data re-
spectively;

» for processing of spatial data: the Web Processing Service (WPS). Note that
this specification does not standardize the analysis or processing methods
themselves, but rather defines a standardized interface that lets you publish
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geospatial processes, and lets client software find those processes and em-
ploy them.

» for data visualisation in the form of maps there is the Web Map Service
(WMS). This is by far the most mature and widest adopted OWS specifica-
tion. There are numerous open source as well as commercial solutions offer-
ing WMS functionality. Related to WMS are the Styled Layer Descriptor
(SLD) specification, for map styling, and the Web Map Context Documents
(WMCD) specification, for map setup and layout;

« for describing and finding spatial data, there is a set of metadata specifica-
tions in the Catalog Service Web (CSW).

We will use WMS as an example to show the working of OGC specs in a bit
more detail, see the OGC website for more details on the other specifications.

The WMS specification defines four interfaces: GetCapabilities, GetMap,
GetLegendGraphic and GetFeaturelnfo.

The GetCapabilities interface is used by client software to ask for the capabili-
ties of the service: what layers are available, what projection systems can the
maps be delivered in, what output formats can be requested, etc.

So if you point your browser to the URL:

http://geoserver.itc.nl/cgi-bin/mapserv.exe?
map=d:/Inetpub/mapserver/

config.map&SERVICE= WMS&VERSION=1.1.1&REQUEST=GetCapabilities

the service will return an XML file describing the capabilities. It is human-read-
able text, but not really meant for reading: Software (GIS or mapping clients)
will parse it to be able to show layers, zoom to the extent, know what projection
to use, etc...

Based on the GetCapabilities result, the GetMap request is issued to ask for an
actual map. Because the client knows the possibilities of the service from the
GetCapabilities response, it can issue its request with specific parameters ask-
ing for example for a one or more layers of information (LAYERS=borders, for-
est), in a certain part of the world (BBOX=x1,y1,x2,y2). It will also request that
the output is returned in a format that the client can handle (e.g., a web
browser will request FORMAT=image/png), and in a specific size in pixels (e.g.,
WIDTH=250&HEIGHT=300). Furthermore, the map output will have to be be
requested in a specific projection (SRS=EPSG:4362).

The SRS, or Spatial Reference System is usually expressed as an EPSG code.
EPSG is the European Petroleum Standards Group, and their standardized de-
scriptions of datums and projections are used worldwide. See http://spa-
tialreference.org for an overview.
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Thus, if you type in the URL:

http://geoserver.itc.nl/cgi-bin/mapserv.exe?
map=D:/Inetpub/mapserver/
config.map&SERVICE=WMS&VERSION=1.1.1&REQUEST=GetMap
&LAYERS=forest, railroad,airports

&STYLES=

&SRS=EPSG:4326

§BROX=97,5, 105, 20

&SWIDTH=400&HEIGHT=600

&FORMAT=1mage/png

in a web browser, the WMS at that site will return the graphic shown in
Figure B.4.

If the user of a mapping client triggers a zoom command, the client will issue a
new GetMap request, now with a smaller BBOX. This process will be repeated
over and over again while the user interacts with the map.

The GetLegendGraphic request is used in a similar fashion to get a pictorial
rendering of a legend item separately.

In WMS services that advertise layers of data as queryable, the GetFeaturelnfo
request can be used to find attribute values in the underlying data. The client
software reports the location of a request in pixel coordinates within the map
graphic, and requests theWMS to report on the attribute values of the location
in specific layers. The WMS thus has to take into account the size in pixels and
in real world coordinates of the graphic it has supplied, plus any reprojections is
has done, to calculate the request location in the coordinate space of the origi-

e

Fig. B.4: Result of the WMS re-
quest in the URL.
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nal data. It then finds data objects at that location, and does a lookup in the
original data store (a vector or raster file, a database, etc) to find appropriate
data attributes. It then reports these back to the client in the format requested
(plain text, HTML or XML).

You can experiment with the WMS and other OWS services at our website.

http://geoserver.itc.nl/mapserver/

An easy way to see how the different parameters of the interfaces work is the
testing form at:

http://geoserver.itc.nl/mapserver/testURL.html

B.3.2. Mapping in a Service Oriented Architecture environment

The principle of disseminating maps in a webservices environment is depicted
in Figure B.5. This general setup is being used in many of today’s webmapping
efforts, with considerable variation in the choice of technology for the mapping
service and the subsequent map formats. This choice to a large extent defines
the possibilities of the system as a whole to achieve what we call the automatic
and direct production of maps.

By “direct” we mean that the maps are generated on-the-fly from the data. This
is necessary because the map generation should fit in interoperable Spatial
Data Infrastructures, and it guarantees the maps are always upto-date. To
achieve this directness, the visualization functionality should be loosely coupled
to the other parts of the system. The Open Geospatial Consortium’s (OGC)
Open Web Services (OWS) and related specifications are especially useful for
this. These web-services are designed to take their input from a variety of dis-
tributed sources and generate output meant for Internet dissemination.

We consider “automatic” to mean that the maps will be generated from the data
by the system “working by itself with little or no direct human control”. It is im-
portant to note that this automation in most current systems does not include
the cartographic decisions as to what type of map to use for different datatypes
and data instances. The link between data- and visualisation-type has to be
made by a human (the cartographer in Figure B.5), setting up the appropriate
service configuration.

Servi
"} ' mnﬂgug
I

B cantographer
a2

Fig. B.5: General principle of dissemination of maps in a Service Oriented Architecture.
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B.3.3. The FOSS4G geo-webservices stack

We use geowebservices at ITC in teaching, research and projects. Students
and staff build services and clients using a software and data stack that is em-
ploying so called Free and Open Source Solutions for Geospatial (or FOSS4G
for short). This Open Source stack can be set up using a wide choice of soft-
ware.

We use a set-up that we call SDI-light. The term SDI for Spatial Data Infrastruc-
ture may be usually connected with (very) large regional or national spatial data
warehouses, but the principles of SDI can also be applied in more simple and
cost effective ways. The down-to-earth approach of SDI-light provides re-
searchers and students alike with a proof of concept platform for relatively sim-
ple, low cost, yet powerful ways of sharing data amongst various distributed of-
fices and institutions as well as the general public. To achieve this, we use
open standards whenever available, opensource solutions where possible and
commercial software where necessary (more about SDI-light in Kébben et
al (2010)).

In general, the main building blocks we use are:

» A spatial database backend that stores the spatial data using the Open
Geospatial Consortium Simple Features specifications. As a platform, the
PostGIS extension to the object relational DBMS PostgreSQL is a logical
choice. First, because PostgreSQL is a solid DBMS that has a reasonably
gentle learning curve, yet is wonderfully appropriate for advanced database
applications, and its documentation is very transparent. PostGIS in addition,
is the leading open standards implementation of spatial vector management,
and enjoys a lively and supportive user/developer community.

* A set of interoperable middleware web applications that interface with the
database backend and with each other, and fulfill tasks such as delivering
maps for visualisation purposes or providing data and processing services.
We use existing open source solutions, mainly MapServer and GeoServer.

GOMLIOGR : L '___.- A _._:..:.
Prajd vl r.-" :
i ] Gentoah!
;i [ GEQS ! E i
& I LI ' Fig. B.7: Screendump of the interact-

Fig. B.6: The Open Source stack used in ITC’s ive map part of the Melka Kunture Vir-
SDI-ight. tual Museum.
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« Simple (thin) browser-based clients enabling access to the maps and data.
We employ the OpenlLayers APl and Scalable Vector Graphics (SVG). There
are also more established standalone (thick) clients: We use QuantumGIS
for map viewing, data analysis and editing.

B.3.4. An application example: The Melka Kunture Virtual Museum

One website that uses this stack is the Melka Kunture Virtual Museum at:

http://geoserver.itc.nl/melkakunture/

Melka Kunture lies in the upper Awash valley, 50 km south of Addis Abeba
(Ethiopia). It is the site of very important archeological finds and 70 archaeolog-
ical levels have been discovered so far, the oldest dating back to about 1.7 mil-
lion years. In 2003 the Museum of Melka Kunture was built, and in 2007 a Vir-
tual Museum was put on the WWW. It represents not only the four buildings
and the Open Air Museum, but also gives access (in the For Scientists section)
to the vast amount of spatial data of the excavations and various finds. All ele-
ments have been stored in a spatial database. We use MapServer to provide
WMSes for the excavation data and the OpenLayers script offers these as in-
teractive map views in the web pages. Custom Javascript on client-and server-
side provides further links from the spatial excavation data to the content of the
museum exhibition panels, and the other way around. In this way, users can
click on finds in the map, find more data (and sometimes drawings and photos)
of that element, as well as links to the appropriate museum sections.

Further reading

This further reading explains the ITC FOSS4G software stack and its use in ed-
ucation, research and projects.

OGC website. http://www.opengeospatial.org/. This is the offcial home page of the Open
Geospatial Consortium, where you can find all relevant standards and information
about them.

Kébben Barend; de By, Rolf; Foerster Theodor (2010) Using the SDllight approach in
teaching a Geoinformatics Master. Transactions in GIS, 14 : s1, pp. 25-37.
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Introduction to the OSGeo Live System

Version 2.0 - September 18, 2012

Key points

In this section the starting of OSGEO LIVE system is explained. For the fol-
lowing hands-on examipes we will be using the free and open source GIS and
webmapping applications from the OSGEO LIVE system...

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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The Open Source Geospatial Foundation, or OSGEOQ, is a not-for-profit organ-
ization whose mission is to support and promote the collaborative development
of open geospatial technologies and data. The foundation provides financial,
organizational and legal support to the broader open source geospatial com-
munity. OSGeo also serves as an outreach and advocacy organization for the
open source geospatial community, and provides a common forum and shared
infrastructure for improving cross-project collaboration.

The foundation’s projects are all freely available and useable under an OSl-cer-
tified open source license. More information at the website:

http://www.osgeo.org/

The OSGEO LiveDVD (the current version is OSGeo-Live 6.0) is a self-con-
tained bootable DVD, USB drive or Virtual Machine based on the Xubuntu op-
erating system, that allows you to try a wide variety of open source geospatial
software without installing anything. It is composed entirely of free software, al-
lowing it to be freely distributed, duplicated and passed around.

It provides pre-configured applications for a o=
range of geospatial use cases, including stor-
age, publishing, viewing, analysis and manip-
ulation of data. It also contains sample data-
sets and documentation.

Many applications are also provided with in-
stallers for Apple OSX and Microsoft Win-
dows. More information, including alternative
disk images and installations, can be found
on the website:

http://live.osgeo.org/

Task 1 : To use the OSGEO LiveDVD, simply:
1. Insert the DVD or the USB stick in a computer.

2. Reboot the computer. In Microsoft Windows, you might have to verify
or set the boot device order, to allow startup from a CD (mostly by
pressing a key during start-up, typically the F12 key). On Apple OSX,
to boot from CD, you hold the C-key while restarting.

3. For CD booting: Wait for the “boot:.” prompt, then press “Enter” to
startup and login.

4. For USB booting, you should see a menu where you choose the first
option (start normally).

The Xubuntu OS should start up, and now you should have a desktop similar
to the figure below (depending on the version of the LiveDVD you are using).
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A Simple Map Client in a Webpage
OpenStreetMap in an OpenlLayers Website

Version 3.9 - September 17, 2012

D.1. Short introduction to JavaScript
D.1.1. Embedding Javascript in a web page
D.1.2. JavaScript Objects and the Document Object Model
D.1.2.1. The document.write method
D.1.2.2. The document.getElementByld method
D.1.3. Using functions
D.2. Open Data: using OpenStreetMap
D.3. The OpenlLayers API
D.4. Making an OpenLayers viewer for OpenStreetMap

Key points

This is a reference for the use of OpenLayers, a JavaScript Library based on
AJAX-principles (Asynchronous JavaScript And XML). OpenLayers can be
used to build general WebMapping clients, among others to connect to OGC
Web Map Services. In this exercise we will us it to create a web page that

gives you access to OpenStreetMap, an Open Data map service. You will
learn how to:

» learn the principles of client-side Javascript;
* Use the OpenLayers library in a web page;
+ Make a simple map using the OpenStreetMap background.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-

ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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D.1. Short introduction to JavaScript

! — You are advised to read is page in your web browser, because you can
then see how the actual examples work. You can find the web page either in
the appropriate BlackBoard module as a link to Dynamic HTML and scripting or
directly at: http://kartoweb.itc.nl/courses/JavaScriptExamples/

Javascript allows us to create and change webpages programmatically,
through the use of Dynamic HTML. DHTML is built on top of HTML. That is,
DHTML includes all the elements that make up a traditional web page. How-
ever, with DHTML all of those elements are now programmable objects. You
can assign each element an ID and then use scripting to alter them after the
page has been downloaded.

Dynamic HTML allows you to dynamically control the look and content of a
Web page. For example, the web page has an line of text that dynamically
changes colour if you move the mouse over it. To achieve this, we have added
the id attribute to the HTML element <H4>, and assigned the id the value "my-
Header", thus creating a programmable object:

<H4 1id="myHeader">THIS WILL CHANGE IF THE MOUSE MOVES OVER
IT...</H4>

Then we've added calls to two script functions to the object, that will be trig-
gered by events (i.e. actions by the user or the web browser) in this case the
onmouseover and the onmouseout events:

<H4 id="myHeader" onmouseover="ChangeColor ()" onmouseout="
ChangeBack () ">
THIS WILL CHANGE IF THE MOUSE MOVES OVER IT...</H4>

Finally we’ve added the actual script functions, using the JavaScript language,
that will retrieve the programmable object by its name and change the colour
attribute of its style:

<SCRIPT LANGUAGE="JavaScript">
function ChangeColor ()

{ document.getElementById ("myHeader™) .style.color = "blue"; }
function ChangeBack ()

{ document.getElementById ("myHeader™) .style.color = "black"; }
</SCRIPT>

On the web page you will find links to other examples of what you can achieve
with scripting DHTML.

From the name alone, you might think JavaScript is like the programming lan-
guage Java. However, the JavaScript language resembles Java in some ways,
but does not have its static typing and strong type checking. JavaScript does
support most Java expression syntax and basic control-flow constructs.

In contrast to Java’'s compile-time system of classes built by declarations,
JavaScript supports a runtime system based on a small number of data types
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representing numeric, Boolean, and string values. This results in so called
loose typing, which means variable data types do not have to be declared
specifically: if you assign a string value to a variable, it automatically will be-
come a string type variable! JavaScript is interpreted (not compiled) by the
client software (usually the browser). The code is integrated with, and embed-
ded in, HTML.

D.1.1. Embedding Javascript in a web page
You can embed JavaScript in an HTML document in the following ways:

1. By specifying a JavaScript expression as the value of an HTML attrib-
ute, using an event handler, as demonstrated in the previous section.
2. As statements and functions within a <SCRIPT> tag.

Task 1: In listing 1 you find a simple script.

Create a new, empty, WWW-page in coding mode (e.g., use NotePad++,
TextWrangeler, Medit (or a similar smart editor). Type the JavaScript and
HTML code as shown in listing 1 into the HTML-code editor window.

Save the page and open it in a web browser: It should display the following in
the browser:

This is scripted content! This is plain HTML...

Notice that there is no difference in appearance between the first line, gener-
ated with JavaScript, and the second line, generated with plain HTML.

The <SCRIPT> tag is an extension to HTML that can enclose any number of
(Java)Script statements. A document can have multiple script tags, and each
can enclose any number of JavaScript statements.

Listing 1: A simple scripted page
<HTML>
<HEAD>
<SCRIPT LANGUAGE="JavaScript">
document.write ("This is scripted content!");
</SCRIPT>
</HEAD>
<BODY>
<P>This is plain HTML... </P>
</BODY>
</HTML>

Generally, you should define the JavaScript for a page in the HEAD portion of a
document. That way, all functions are defined before any content is displayed.
Otherwise, the user might perform an action while the page is still loading that
triggers an event handler and calls an undefined function, leading to an error.
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Rather than embedding the JavaScript in the HTML, the SRC attribute of the
<SCRIPT> tag lets you specify a file as the JavaScript source. For example:

<SCRIPT LANGUAGE="JavaScript" SRC="common.js"></SCRIPT>

This is especially useful for sharing the same JavaScript code among many
different pages. Note the ending </SCRIPT> tag is necessary to create a valid
HTML script object! The SRC attribute can specify any URL, relative or abso-
lute. For example:

SRC="http://www.mysite.com/functions/jsfuncs.js"

External JavaScript files cannot contain any HTML tags: they must contain only
JavaScript statements and function definitions. External JavaScript files should
have the file name suffix .js.

Task 2: Open a new empty file.

Put the JavaScript you used in Task 1 into this file (you can use copy and
paste) and save this file. Change the Web Page you made in Task 1, so that it
calls the JavaScript from a code file, instead of having the code embedded.

D.1.2. JavaScript Objects and the Document Object Model

JavaScript is an object oriented language, like Python, C++, Java and many
others. There are several types of objects you can use:

JavaScript core language objects: these are objects that are part of the
JavaScript language. Examples are the Date object that can be used to manip-
ulate dates and times, the String object for manipulating text strings and the
Math object for manipulating numbers.

Browser or Document Object Model (DOM) objects: the parts of the browser
and web page that are made accessible to the scripting language are struc-
tured in the so-called Document Object Model (DOM); this is a structured hier-
archical object tree that provides a way to control elements on the page using
scripting, provides multimedia controls for animations and other effects, and
provides a way to bind data to an HTML page. Unfortunately, the browser man-
ufacturers have not yet agreed on one common DOM, therefore there are small
differences in the DOM for different browsers. The scheme in figure D.1 shows
you the structure of the lowest common—denominator DOM. The DOM objects
can be used to manipulate the HTML webpage, and turn it into DHTML, as
shown in the examples in further sections.

D.1.2.1. The document.write method

As you saw in the previous example, the write() method of the DOM object doc-
ument displays output in the browser, and its syntax follows JavaScripts stan-
dard object notation: objectName.methodName (arguments), where object-
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Fig. D.1: The lowest common—denominator DOM.

Name is the name of the object, methodName is the name of the method, and
arguments i$ a list of arguments to the method, separated by commas.

“Big deal,” you say, “HTML already does allow me to write text in a web page.”
But in a script you can do all kinds of things you can’t do with ordinary HTML.
For example, you can display text conditionally or based on variable argu-
ments. For these reasons, write is one of the most often—used methods. The
write method takes any number of arguments, that can be string literals (a text
between quotes that will be show literally), or variables, that is any variable that
evaluates to a string value. You can also use the string concatenation operator
(+) to create one long string from several separate ones, thus after running the
script fragment:

myNameString = "Barend Kobben";
myStringVar = "My name 1is " + myNameString;

myStringVar would have the value My name is Barend Kobben.

Task 3: Write a script that shows the line “Hello, it is now:...” , where the ...
part is showing the current date and time.
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To achieve this, you should use:

» the method write() of the DOM object document;
» the JavaScript built—in method pate() that returns the current date and
time.

D.1.2.2. The document.getElementByld method

Another much used DOM method was already used in the first section: The
getElementById method of the document object. This finds an HTML object by
its unique ID, thus creating a programmable object. You can assign an ID to
virtually all HTML objects, by simply adding an attribute id="someID" to it. You
have to take care yourself the ID is unique!

D.1.3. Using functions

Functions are one of the fundamental building blocks in JavaScript. A function
is a JavaScript procedure — a set of statements that performs a specific task.
A function definition has these basic parts:

* The function keyword;

¢ A function name;

* A comma-separated list of arguments to the function (in parentheses);
* The statements in the function {in curly braces}.

It's important to understand the difference between defining and calling a func-
tion. Defining the function simply names the function and specifies what to do
when the function is called. Calling the function actually performs the specified
actions with the indicated parameters.

Task 4: Open a new empty W\WW-page.

Type the code shown in listing 2 into the HTML-editor window. Save the page
and open it in a web browser.

Listing 2: A simple function
<HTML>
<HEAD>
<SCRIPT LANGUAGE="JavaScript">
function square (number) {
return number * number;
}
</SCRIPT>
</HEAD>
<BODY>
<SCRIPT>
document.write ("The function returns:

"

, square(5), ".™);
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</SCRIPT>

<P>All done.</P>

</BODY>

</HTML>

This script defines a simple function in the HEAD of a document and then calls
it in the BODY of the document: The function square takes one argument,
called number. The function consists of one statement. return number *
number;. The return statement specifies which value will be returned by the
function, so this means the function will return as result the argument of the
function multiplied by itself. In the BODY of the document, the statement
square (5) calls the function with an argument of 5. The function executes its
statements and returns the value 25.

We now have some basic working knowledge of Javascript. Now let’s put it to
use in an actual web-mapping application!

D.2. Open Data: using OpenStreetMap

First we'll show you a prime source of free maps and data on the web: Open-
StreetMap.

Note: The OpenStreetMap Project, based at openstreetmap. org, is the world-
wide mapping effort that includes more than 400,000 volunteers around the
globe. OpenStreetMap is an initiative to create and provide free geographic
data, such as street maps, to anyone.

There are many ways in which you can access the OpenStreetMap: as a
simple webmapping service (not unlike Google and Bing Maps, but based on
truly free non-proprietary data on a non-commercial website), as a webservice
in various GIS viewers and as a database service, providing the actual vector
data in raw form.

Task 5: Visit http://www.openstreetmap.org/ using a web browser.

Try to find the location you are currently in, by zooming and panning.

The OpenStreetMap site itself uses the OpenlLayers Javascript API, just as we
will do later ourselves. The icons you see in the map are the default Graphics
User Interface (GUI) of OpenlLayers. They offer the following interactivity:

* You can pan using the arrow icons, or by dragging the map;
* You can zoom in using the + icon, or shift—-drag a zoom box in the map;
* You can zoom out using the — icon;
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Using the OpenStreetMap site as described above is fine for casual map
browsing, but if you want to disseminate spatial data yourself, you might want
to include the OpenStreetMap in your own websites. And of course that is pos-
sible. We will use a popular browser—based mapping library for creating such a
site: OpenLayers.

D.3. The OpenLayers API

OpenLayers makes it easy to put a dynamic map in any web page. It can dis-
play map tiles and markers loaded from any source.

Note: OpenlLayers is a pure JavaScript library for displaying map data in most
modern web browsers, with no server-side dependencies. OpenlLayers imple-
ments a JavaScript APl (Application Programming Interface) for building rich
web-based geographic applications, similar to the Google Maps, with one im-
portant difference: OpenlLayers is Free Software, developed for and by the
Open Source software community based at http://openlayers.org/. OpenlLayers
is written in object-oriented JavaScript, using components from Prototype.js
and the Rico library. In this exercise, we will only show the basic building
blocks, and how to employ them. Those wanting to go further, should check out
the development pages and the examples at the website.

The latest version of the OpenlLayers script library is always available on the
OpenLayers website. You can “install” the API by in-
cluding a link to the Javascript files in your own
HTML web-pages and then call the methods and
properties of the library using simple JavaScript
functions. Using the Openlayers API is done by cre-
ating webpages (using HTML) that include
Javascript script; this code makes calls to the API
methods to create the necessary map object and
connect that to an HTML placeholder. Mostly we
use an HTML <div> element as a placeholder.

The OpenLayers API has two concepts which are
important to understand in order to build your first gome content
map: Map, and Layer. An OpenlLayers Map stores <diwvyz
information about the default projection, extents, </html>
units, and so on of the map. Inside the map, data is
displayed via Layers. A Layer is a data source - in-
formation about how OpenLayers should request My Webpage

data and display it. WWe then uses the methods and some content
properties of the API to change the content and be-
haviour of the map. In practice, all this means typing % ;

(and/or copying) HTML and JavaScript code. -»
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D.4. Making an OpenLayers viewer for OpenStreetMap

In listing 3 you see the most basic example of using OpenLayers with the
OpenStreetMap service.

Task 6: Create an HTML page with the content of listing 1 and save it as a os-
m.html.

You can type the code, but it is easier to copy it from the file we stored in the
filefragments folder. Do not copy from this PDF file! Make sure you save this
file as a new file with the extension .html, not .html.txt!).

View the result in a web browser.

Listing 3: osm.htm|

<!DOCTYPE html><html> html document starts
<head> html header starts
<script
src="http://localhost/openlayers/Openlayers.js"></script> load
the API
<script type="text/javascript"> script for our map
var myMap, myOSMLayer; define map and layer object
var myCenter = new Openlayers.LonLat ( define center
254031, 6254016 XY of Paris
)
function init () { function triggered on load
myMap = new Openlayers.Map ("mapDiv") ; create map object
myOSMLayer = new OpenlLayers.Layer.0OSM("OSM Map") ; create OSM
layer
myMap.addLayers ( [myOSMLayer]) ; add layer to map
myMap.setCenter (myCenter, 16) ; zoom to center
}
</script>
</head>
<body onload="init ()"> run init script
<div id="mapDiv" map placeholder
style="width:400px; height:400px;"></div> placeholder style
</body></html >

The result should look like figure D.2, showing the OpenStreetMap for the
Porte Maillot area in Paris (France).

You can set up the OpenStreetMap to start at any place on the globe, by
changing the coordinates that were used in the myCenter variable:

var myCenter = new Openlayers.LonLat (254031,6254016) ;
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But in order to find which coordinates to use to zoom to, it would be nice to

have a knowledge of where (in coordinates) you are in the map. For that we will
include a coordinate readout line and a scale bar:

Task 7: Add the following line in the script just before the line with the
myMap.SetCenter command:

myMap.addControl (new Openlayers.Control .MousePosition () ) ;
myMap.addControl (new Openlayers.Control.Scaleline() )

Save the results as osmPlusCoordinates.html. Try out the result in the
browser.

The coordinates you see are X— and Y—coordinates in a Mercator projection on
the spherical WGS84 datum. This is used nowadays by most popular public
webmapping services (such as Google Maps, Bing Maps and OpenStreetMap).
The projection is officially standardized as EPSG code 3857, and named “WGS
84 / Pseudo-Mercator”. Unfortunately, lots of software uses instead the un-offi-
cial EPSG code 900913 (chosen because it sort of spells “google™), that was in-
troduced and has become popular before the official standard was set.

Now you can change the line myMap.setCenter(myCenter,16) to set an alter-

native starting point (change myCenter variable) and zoom (from 0-18) for the
map.

Task 8: Try setting up the map in such a way, that it starts zoomed in on your
current location.
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Fig. D.2: result of loading listing 1.
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Creating data in a desktop GIS
using Quantum GIS

Version 2.0 - September 18, 2012

E.1. Introduction to QGIS

E.2. Connecting QGIS to Web Map Services
E.3. Using OpenStreetMap as a layer in QGIS
E.4. Using QGIS to create your own data

Key points

The web page we made in the lesson about using Open-StreetMap in Open-
Layers is nice, but what if we want to add our own data to that map? In order
to do that, we shall first have to create such data. We will do that using the
same OpenStreetMap as a reference and using QGIS, a free Open Source
Gls.

Note that this exercise assumes you are using the OSGEO LIVE system, and
that you have previously done the exercise “Using OpenStreetMap in an
OpenLayers website”.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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E.1. Introduction to QGIS

QGIS (officially QuantumGIS, hitp://qgis.org) is an Open Source, stand-alone
GIS client, programmed in C++ using the multi-platform Qt framework. You can
use it to work with vector- and raster files, databases or any open standard
WMS or WFS compliant server. A strong point of QGIS is its extensibility: you
can add plugins that are written in either C++ or Python, and you can connect it
to GRASS, a powerful GIS analysis tool.

Task 1: ITC users can just double click (or copy) the shortcut that they find at
P:\QuantumGIS\Quantum GIS to their own computer.

If you are using the OSGEO LIVE system, you can start QGIS by going to the
menu Geospatial > Desktop GIS > Quantum GIS.

Other users go to the URL http://qgis.org/ and download and install the latest
(stable) version for their operating system.

QGIS can load maps and data from a huge array of possible sources:

» online maps served as an OGC-compliant Web Map Service (WMS);

« online spatial data served as an OGC-compliant Web Feature Service
(WFS) and Web Coverage Services (WCS);

» various other map services, such as OpenStreetMap, Google Maps, Bing
Maps, etcetera;

« most vector formats supported by the OGR library, including ESRI
shapefiles, Maplnfo, KML, GPX and GML,;

« raster formats supported by the GDAL library, such as digital elevation mod-
els, aerial photography or satellite imagery;

» spatially-enabled PostgreSQL tables using PostGIS and Spatialite, by
means of a “live” connection to such databases;

* locations and mapsets from GRASS (an open source GIS);

The list is in principle endless, because the functionality of QGIS can be ex-
tended by plugins. Plugins add functionality to QGIS, and they are usually
made by others than the main QGIS developers. Because QGIS is an Open
Source software, anyone can add plugins, they can be programmed using C++
or Python.
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E.2. Connecting QGIS to Web Map Services

Task 2: Choose the Layer > Add WMS Layer.. menu or click the WMS layer
icon. You can choose your server Connection from the list.

This list can be initially filled with some well-known services by clicking “Add
default servers”. Try to find the service provided by LizardTech server.
Once you have selected it and clicked the Connect button, the software sends
a so—called GetCapabilities request to the WMS. The resulting XML descrip-
tion of the capabilities of the service will be parsed by QGIS and it will display
the layers that were advertised as being available.

Try to find and load a layer that displays a satellite image of the whole earth.
This will usually be the so called BMNG, the “Blue Marble Next Generation”.
This is a dataset created from MODIS satellite images by NASA JPL.

You can also add your own WMS connections to this list, e.g., to the ITC WMS
services:

Task 3: Choose again the Layer > Add wWMS Layer... menu (or click the
WMS layer icon). Now add your own server connection by clicking “New”. In
the Name field you can give any name for the connection you want. In the
URL field you put the so called root URL, where the software can find the Get-
Capabilities interface of the service.

Use this URL for a general world map provided by ITC WMS services:

http://geoserver.itc.nl/cgi-bin/mapserv.exe?
map=D:/Inetpub/geoserver/mapserver/ config world.mapé&

Now that connection is added, you can use it like the previous one to retrieve
capabilities and load WMS layers.

Add Laanish from 3 Soraer
P Serwar . Serenr Seaich

Mok Thailwre Wds

(Comnec 1 Mew 1 Ecit ) Delete | [ Add delaalt serers |
i Mttt it el il el

o 5 CrRan: & Ew WM £10 (R4

ot v arTans el

Bmmm | My Thaland L
Uk '|.'.D\..l.l-q;ﬂl.lﬂ:'\l'.ﬂ:.h icg = - n.:rm.:-h:.;'\-.l.:o;:‘l:nl.:h h Jine
S WV renuires Basic suthenficabion. enier & user name amsd
calicral paszsced
iTageaxocing
FGF RS Mser nams Faswned
Capein e Beleed e (Canced | D

W B

Fig. E.1: Add layers from a server.
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Using these techniques, you can use any WMS available on the internet or
your local intranet. The only thing you need to know is the the root URL, where
the GetCapabilities interface of the service can be found. E.g., if have learned
how to use ArcGIS Server to publish a OGC-compliant WMS from an ArcMap
(.mxd) file, or if you have learned how to use Geoserver: To access these ser-
vices in QGIS, again you would use the “base URL” to the service.

E.3. Using OpenStreetMap as a layer in QGIS

The extensibility of QGIS can serve us well: we can use several existing geo-
webservices as background layers by means of the “Open-Layers Plugin™:

Task 4:

Start QGIS. To enable the use of OpenStreetMap, we will enable the plug—in
that offers that functionality: Open the menu Plugins > Manage Plugins...
From the list, find the one called “OpenLayers plugin” and enable it by making
sure it is selected. Press OK.

Now open the menu plugins again. A new item called openlLayers Plugin
should have been added. Choose Add OpenstreetMap layer from this sub-
menu, and the OpenStreetMap will be opened, zoomed out on the whole
world.

Navigate to the location you saved for webpage you made earlier (your own
place or the Porte Maillot).

QGIS is not limited to OpenStreetMap, it can load maps and data from a huge
array of possible sources, such as Google, Bing and Yahoo Maps.

Q 0GIS Plugin Manager + X
Filter |
To enable / disable a plugin, click its checkbox or description

OGR2Layers (Version 0.8.1) =

A plugin to export OGR layers to OpenLayers HTML
OSMPOLY_export (0.1.4)

Generate Poly files used by Osmosis from layers
OfflineEditing

Allow offline editing and synchronizing with database

OpenAddresses converter (Version 1.0)
Convert openaddresses xml format to shape file

OpenLayers Plugin (0.42)

v OpensStreetMap, Google Maps, Yahoo Maps layers and more

OpenStreetMap plugin (Version 0.5)
Viewer and editor for OpenStreetMap data =l

Plugin Directory: fusr/lib/qgis/plugins

OK I Select All Clear All Cancel I

Fig. E.2: QGIS Plugin Manager.
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It also allows you to create data in many of these formats, and that is was we
are going to do next...

E.4. Using QGIS to create your own data

We will create a very simple vector line dataset, that depicts a walking or run-
ning route. You could for example try to digitize the road you took this morning
from your hotel to the conference location...

When creating new data, QGIS will adopt the projection of the current project.
Therefore we must make sure that the data is saved correctly projected, other-
wise our new layer won't fit the OpenStreetMap base later on:

Task 5: Choose the menu Layer > New > New Shapefile Layer...
The New Layer dialog opens (see below). Make the following settings:
1. For Type choose Line;

2. Click Specify CRS and make sure you choose the Google Mercator
(EPSG:3857 or EPSG:900913). It can be found under Projected

Coordinate Systems > Mercator;

3. In the New attribute section, create one attribute, named routeName,
of type Text. Click the Add to attribute list button to actually add it;

4. Click OK to create the new file. Save it on your Hard Disk or the USB
stick and name it “myRoutes.shp” [if this is not possible with your con-
figuration, you will be have to later use the prepared file at the web-
site].

Now you can start adding lines for your route:

Click first the Toggle Editing button in the QGIS menubar, then the cap-
ture Line button. Create a nice walking route, e.g. one near the conference
centre. You can add points to the line by clicking in the map, undo them by
using the CTRL-Z key or Edit > Undoc menu.

If you have finished a route, right-click, fill in the route name and press OK.
Use the Toggle Editing button again to stop editing. You can change the
visualisation of the line by right-clicking the layer name in the layers list, or
choosing the Layer > Properties menu.
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You now have created your own data. But only you can look at it, locally using
your GIS viewer. In order to publish this in your web site, you’ll have to turn the
data into a webservice. We will do that by creating an Open Standard WMS
service, and we will use the MapServer and/or GeoServer software to publish
it.

Fig. E.3: Example of own data input.
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F. Serving Data as an OGC Web Map Service
Using WMS with UMN Mapserver

Version 1.0 - September 18, 2012

F.1. Setup of MapServer for the OSGEO LIVE environment
F.1.1. Setup parameters
F.1.2. Installing the exercisedata
F.2. Introduction of MapServer WMS
F.2.1. Basic parameters of a mapfile
F.2.2. Testing your Map File
F.3. Making class maps
F.4. Hiding and showing layers at predefined scales
F.5. Creating symbols
F.5.1. Line Symbols
F.5.2. Simple Point Symbols
F.5.3. Font-based PointS ymbols
F.6. Labelling your map
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Key points

In this exercise you wil learn how to set up the software MapServer as a Web
Map Service using the Open Geospatial Consortium’s OWS standards. This
exercise is geared towards using it in the OSGEO LIVE DVD environment.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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F.1. Setup of MapServer for the OSGEO LIVE environment

F.1.1. Setup parameters

The MapServer software comes pre-installed on the OSGEO LIVE environ-
ment. You will place all the MapServer configuration files, templates etc., inside
the special exercise directory “thailand” that is also pre-instaled or given to you
by the workshop teachers. You can use only this location!

These 3 parameters will be needed repeatedly in the following exercises:

<CGIPATH> = http://localhost/cgi-bin/mapserv
<NETPATH> = /home/user/thailand
<URLPATH> = http://localhost/thailand

The <CGIPATH> points tothe location where the webserver can reach the
MapServer CGl software.

The <NETPATH> points to your map configuration files as they should be read
by the MapServer.

The <URLPATH> points to the web location where a browser can find the out-
put of the MapServer, e.g., HTML files, temporary image files or HTML tem-
plates.

F.1.2. Installing the exercise data

You will have to make sure the data for the Thailand OWS exercises is in-
stalled. This data might be already in a folder “thailand” on the desktop. Other-
wise, it can be found on the CD/DVD/USB stick you were given, and the work-
shop teachers will tell you how to install it.

Task 1: To test if the Apache web server is running properly, open your WWeb
browser and find your local host Web service by entering the following URL.:
http://localhost/.

Localhost is a shortcut telling your browser to connect to the local machine as
a server. You should now see the main OSGEO LIVE page in your Web

browser. This gives you general information about your installation along with
configuration information for the OSGEO Live applications.

Now point a browser to the URL: <URLPATH>/index.html

A web page with the text “This is the home page for the Thailand OWS exer-
cise site...” should appear.
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Fig. F.1: Structure of exercise data
folder “thailand”.

F.2. Introduction of MapServer WMS

A Web Map Service produces maps of georeferenced data. A “map” is just a
visual representation of geodata; a map is not the data itself. These maps are
generally rendered in a pictorial format such as PNG, GIF or JPEG, or occa-
sionally as vector-based graphical elements in Scalable Vector Graphics (SVG)
or Web Computer Graphics Metafile (WebCGM) formats.

In these exercises we’ll use the software called MapServer for implementing
the WMS. MapServer is an Open Source (OS) application for constructing spa-
tially enabled web sites. It builds upon several existing popular OS libraries
((e.g., Proj4, GDAL/OGR) and runs on *nix systems (Linux/Unix‘MacOSX) as
well as Windows. It was originally developed in 1994 at the University of Minne-
sota (USA), funded by NASA. It can be connected to numerous spatial data
stores: Vector support is built—in for Shapefiles, ArcSDE , Oracle Spatial and
PostGIS, with the OGR module supporting many other formats. Raster support
goes through the GDAL module supporting more than 30 formats
(e.g. TIFF/GeoTIFF, EPPL7, ECW, Erdas). It can be set up to deliver data ac-
cording to the following OGC specifications: WMS, WFS (not WFS-T), WCS
and SLD and WMCD.

MapServer is a so called Common Gateway Interface (CGI) application, a stan-
dard for interfacing external applications with web servers. Executed on basis
of an URL Request sent to the web server, it is able to provide dynamic/real
time information.

F.2.1. 2.1 Basic parameters of a map file

One configures the MapServer CGI service by providing it a map file, a text file
with the .map suffix that defines an object tree in a hierarchical structure. You
will learn how to set up such map files in the next sections. To get an overall
view about the MapServer .map ‘language’, please take a look at the “MapFile
Reference” on the ITC Blackboard system or directly at the mapserver website
in http://mapserver.org/documentation.htmi
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Fig. F.2: Setup of MapServer CGI

You can now start to create your Map File which will control what the
MapServer does with your GIS dataset:

Task 2: Open the (empty) text file called config.map inside the directory
thailand, using a text editor like WordPad or TextPad (do NOT use MS
Word or another wordprocessor!).

Put the code in listing 1 into this file and save. See the note on page 1 about
entering and copying code!

Make sure you’ve saved the file as config.map, NOT as config.txt or con-
fig.map.txt .

Listing 1: filefragments/config.map.txt
MAP

NAME "Thailand"

IMAGECOLOR 255 255 255

SIZE 600 800

IMAGETYPE PNG24

PROJECTION
"init=epsg:4326" #latlon on WGS84
END
EXTENT 97.35 5.61 105.65 20.47 # lon/lat extents of Thailand
WEB

IMAGEPATH "c:/tmp/ms_tmp/"
IMAGEURL "/ms_tmp/"
METADATA
"ows enable request" "*"
"map" "<NETPATH>/config.map"”
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"ows_schemas location” "http://schemas.opengeospatial.net”
"ows title" "Thailand WMS"

"ows_onlineresource"” "<CGIPATH>?map=<NETPATH>/config.map&"
"ows_srs" "EPSG:4326 " #latlon

"wms_feature info mime type" "text/plain”
"wms_feature info mime type” "text/html"
"wms server version" "1.1.1"
"wms_formatlist"” "image/png,image/gif,image/jpeg”
"wms_format" "image/png"”
END #metadata
END #web

LAYER
NAME "forest"”
TYPE POLYGON
STATUS ON
DATA data/forest
METADATA
"ows title" "forest"
END #metadata
PROJECTION
"init=epsg:4326"
END
CLASS
NAME "forest"”
OUTLINECOLOR 255 255 255
COLOR 137 205 102
END #class forest
END #layer forest
END #map
Map Files are the basic configuration mechanism for MapServer. Anything as-
sociated with a particular application is defined here. The various parts are:

Layer Name and ows_title metadata: Every individual layer needs its own
unique name and title. Layer names are also used in GetMap and GetFeature-
Info requests to refer to layers that should be included in the map output and in
the query. Layer names must start with a letter when setting up a WMS server
(layer names should not start with a digit or have spaces in them).

PROJECTION and ows_srs: WMS servers have to advertise the projection in
which they are able to serve data using EPSG projection codes. In the mapfile,
you define the default projection like this:

PROJECTION
"init=epsg:4326"
END
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Then later in the WEB objects of the map and its individual layers, you can ad-
vertise which projections should be offered by the OWS interfaces, next to the
default one, by specifying one or more EPSG code in the ows_srs parameter.
Note that when asked for a SRS that’s not the default one, Mapserver will have
to re—project the data before turning it into a map. A good place to find which
EPSG code to use for your projection is http:/spatialreference.org/.

By default layers inherit the SRS of their parent layer (the map’s PROJECTION
in the MapServer case). For this reason it is not necessary (but still strongly
recommended) to provide PROJECTION and ows_srs parameters for every
layer. If a layer PROJECTION is not provided then the top-level map PROJEC-
TION will be assumed. Layer PROJECTION and ows_srs metadata are de-
fined exactly the same way as the map’s PROJECTION and ows_srs meta-
data.

The WEB object: The WEB object defines how a web interface (such as OGC
WMS) will operate. The METADATA keyword allows arbitrary data to be stored
as value pairs. This is used with OGC WMS to define such things as ows_title,
ows_onlineresource and ows_srs. If you want to combine layers with different
Spatial Reference Systems, you can list several EPSG codes as shown above.

Per MAP, one or more LAYER objects: The LAYER object describes layers
used to make up a map. Layers are drawn in their order of appearance in the
Map File (first layer is on the bottom, last is on top). The TYPE specifies shows
how the data should be drawn. It normally is the same as the data type. The
DATA parameter specifies the path from your “config.map” file to the data file of
your layer (e.g., a shapefile). Later we will learn how we can add other data
sources (such as PostGIS database connections or raster files).

Per LAYER, zero or more CLASS objects: Embedded in the LAYER object are
CLASS objects which defines the thematic classes for a given layer. How
classes work and what you can do with them you will see in the next sections.
You can make layers without classes, if you do not need styling (e.g. if you get
styles from external styling such as SLD, or if you are making a WFS or WCS).

Per CLASS, zero or more STYLE objects: If you need classes with more than
the simplest styling, you can embed STYLE objects to more freely define class
styles.

Below you will find the list of parameters and metadata items that are optional
for MapServer in general, but are required for a WMS configuration.

At the map level:

+ Map NAME

* Map PROJECTION

* Map Metadata (in the WEB Object):
* ows_title
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« ows_onlineresource. The ows_onlineresource specifies the URL that
should be used to access your server. This is required for the GetCap-
abilities output.

« ows_enable_request. This configures which of the OWS service inter-
faces will be exposed. “** will allow them all.

* OWS_SIS

And for each layer:

+ Layer NAME
» Layer PROJECTION
» Layer Metadata
* ows_title
* ows_srs (optional if you want the layers to inherit the map’s SRS value)

F.2.2. Testing your Map File

To test if your “config.map” file is actually working, we will now request the
WMS services from the MapServer application, through OGC GetCapabilities
and GetMap requests. To display the map server settings using the GetCapa-
bilities request:

Task 3: Type the following URL in a web browser:

<CGIPATH>?map=<NETPATH>/config.map&SERVICE=WMS&VERSTION=1.1.1¢
—REQUEST=GetCapabilities

Note again the <CGIPATH> and <NETPATH> parts that have to be substi-
tuted with the proper paths for your installation! In this URL, you REQUEST
the service operation you want to perform, in this case the OGC WMS stand-
ard request GetCapabilities. The VERSION parameter specifies the protocol
version number. This request will return an XML document.

Look at the XML reply of MapServer. Depending on your web browser setup,
this XML might already be automatically displayed inside your browser after
the GetCapabilities request. In other setups, the browser might not recognise
the XML file as readable output, and there might have been a prompt to open
or save the file. In that case, save the file and open it in a Text Editor or an
XML editor.
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To display an actual map using the GetMap request:

Task 4: Type (or copy) the following URL in a web browser:

<CGIPATH>?map=<NETPATH>/config.map&SERVICE=WMS&VERSION=1.1.1&
—REQUEST=GetMap&LAYERS=forest&STYLES=&SRS=EPSG:4326&
—BBOX=97,5,106, 21&WIDTH=600&HEIGHT=800&FORMAT=image /png

» With REQUEST you define the operation you want to perform

* In LAYERS you list all the layers you want to be displayed

» the STYLES parameter is used to associate styles with the layers. If the
styles list is empty, Mapserver will use the default styles defined in the
map file

* In the SRS parameter you define which Spatial Reference System you want
used

« With the BBOX you set a particular Bounding Box to be requested

* The WIDTH and HEIGHT parameters specify the size in pixels of the map
image to be produced.

« With the FORMAT parameter you state the desired format of the map image

F.3. Making class maps

If you have attributes of your layers you would like use to display different
classes within your layer (e.g. using different colors, a so called chorochromatic
map), you should add more CLASSes and separate them as follows:

Task 5: In the config.map file, change the part from CLASS until END to the
text in listing 2. Check if you now have four CLASS objects (not five, as the
original should have been removed!)

Test the new map.

Listing 2: filefragments/forest.txt
CLASSITEM "FOR TYPE" #use this attribute for classifying
CLASS
NAME "Forest Reserve"
EXPRESSION "FR" #if for type=FR
COLOR 56 168 O
END
CLASS
NAME "National Park"
EXPRESSION "NP" #if for type=NP
COLOR 171 205 102
END
CLASS
NAME "wWildlife Sanctuary”
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EXPRESSION "Ws" #if for type=Ws
COLOR 245 245 122

END

CLASS
NAME "Not forest"”
EXPRESSION "NF" #if for type=NF
COLOR 200 200 200

END

What you see in this example is the layer class of “Forest” was split up into
different types. The name of the column in the attribute table of this shapefile to
be used for the classification is FOR_TYPE. With the parameter CLASSITEM
you tell MapServer which item in the attribute table it has to use in separating
the class object. And with EXPRESSION in each CLASS object you define
which attribute values will become part of this class: if testing the EXPRES-
SION returns TRUE, the feature will be mapped using this CLASS.

With COLOR you define the fill-colour of your object, defined in this case as
three 8-bit values (from 0-255) for Red, Green and Blue respectively. 0 0 0 is
black, 255 255 255 is white, 255 0 0 is full red, etc.

For the stroke—colour you can use OUTLINECOLOR R G B, but here we have
not done that, to have polygons without a stroke.

F.4. Hiding and showing layers at predefined scales

If you would like some layers not to appear until a special scale you can give
them a MAXSCALE. Let’s add a layer for waterbodies, that should only show if
the scale is larger than 1 : 1,000,000:

Task 6: Add the code in listing 3 after the forest LAYER (but before the last
END, which ends the MAP object).

Use the same GetMap request you did earlier, except for changing the LAY-
ERS=forest part to LAYERS=forest,waterbody

Listing 3: filefragments/waterbody.txt
LAYER
NAME waterbody
TYPE POLYGON
STATUS ON
MAXSCALE 1000000
DATA data/waterbody
METADATA
"ows title" "Waterbody"
END
PROJECTION
"init=epsg:4326"
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END
CLASS
NAME "Waterbody"
COLOR 0 0 255
END
END # layer waterbody
Note that the waterbody is not displayed initially. So you’ll have to zoom in until
you reach that scale:

Task 7: Use the same GetMap request you used earlier, expect for changing
the BBOX=97, 5,106, 21 t0 BROX=100, 15, 101, 17.

This means you’ll zoom into the area between the longitudes 100 — 101 and
between the latitudes 15 — 17. Of course this is not a very user—friendly way
of zooming in, but in later exercises we will see how the Beox can be set by a
client—application instead of by typing in the URL.

F.5. Creating symbols

Below we explain some of the basic ways of creating symbols. Symbols in
MapServer are very powerful tools, but can also become quite complex. Basi-
cally, you add one or more STYLE objects to a CLASS to define the symbolisa-
tion. STYLESs can refer to separate SYMBOL objects that define individual sym-
bols to use in one or more styles. For an extensive explanation of creating car-
tographic symbology in MapServer, refer to the document “Constructing Carto-
graphic Symbols” on the MapServer documentation pages at http://mapserv-
er.org/

F.5.1. 5.1 Line Symbols

A simple way to define line symbols in MapServer is to use only default lines
and specify line width and colour:

Task 8: Add the code in listing 4 after the waterbody LAYER.

Use the same GetMap request you did earlier, expect for changing the BBox

back to the original value and changing the 1avErs part to
LAYERS=forest,waterbody, railroad

Listing 4: filefragments/railroad. txt
LAYER

NAME railroad

TYPE LINE

STATUS ON

DATA data/railroad

METADATA

"ows title" "railroad"
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END
PROJECTION
"init=epsg:4326"
END
CLASS
NAME "railroad"
STYLE
COLOR 0 O O
WIDTH 2
END #style
END #class
END #layer railroad

F.5.2. Simple Point Symbols

In order to draw point symbols which are more then a single pixel you will have
to include a SYMBOL object. SYMBOL objects are defined on the hierarchical
level directly below the MAP object. This way, several layers can use the same
symbols. In your LAYER object you have to include a STYLE object that ad-
dresses the SYMBOL you created. The next example creates a simple filled
circle. Using non-equal values for the point will actually render an ellipse.

Task 9: Add the code in listing 5 after the railroad LAYER. Note that the SYM-
BOL object could be moved to anywhere within the MAP file as long as it re-
mains at the same hierarchical level (i.e., the level of the MAP object).

Use the same GetMap request you did earlier, now with

LAYERS=forest,waterbody, railroad, airports

Listing 5: filefragments/airports. txt
SYMBOL

NAME "circle sym"

TYPE ellipse

FILLED true

POINTS

11

END

END #symbol

LAYER
NAME airports
TYPE POINT
STATUS ON
DATA data/airports
METADATA
"ows title" "airports"
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END
PROJECTION
"init=epsg:4326"
END
CLASS
NAME "airports"
STYLE
SYMBOL "circle sym"
SIZE 22
COLOR 0 0 O
END #style
END #class
END #layer airports

The SYMBOL “name” in the STYLE refers to the NAME keyword in the symbol
definition object. The default (when you do not specify any symbol) results in a
single pixel, single width line, or solid polygon fill, depending on layer type.

F.5.3. Font-based Point Symbols

To create symbols that are more than simple circles or squares, you can also
specify a gif or png file by name, to use the graphic in that file as the symbol.
The path of that file should be stated relative to the location of the mapfile. The
disadvantage is that these symbols are raster elements and thus can not be
scaled well.

A more convenient and better scaleable method for creating point symbols is
the use of TrueType font marker symbols, just as software like ArcGIS does.
To achieve that in MapServer, you have to create a font directory with the ac-
tual fonts and a fonts.list file which lists each of the available fonts and the
names you want to address them by. As the ESRI symbol fonts are good to
use for this purpose, we have copied one of them into the font directory and
have included a font list for it (in the directory thailand/fonts).

Task 10: In your Map File you have to specify the FONTSET parameter which
specifies the path to the font list file, just at the start of the MAP object:

MAP
FONTSET "fonts/fonts.list"

.. etc ..

This points MapServer to a fontlist which maps fonthames to fonts in the sys-

tem. Now use the fonts in a symbol definition: Add another SYMBOL into your

MAP object as shown in listing 6.

Then change the SYMBOL name in the STYLE object of the airport LAYER to

"alirport sym".®
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Listing 6: filefragments/airportsymbol.txt
SYMBOL
NAME "airport sym"
TYPE TRUETYPE
FONT "ESRI Default Marker"
FILLED true
ANTIALIAS true
CHARACTER "o"
END #symbol

The CHARACTER is the glyph in the font’s character encoding. It’s the equival-
ent in a ‘normal’ text font of the character you are looking for in the symbol font.
You’'ll need to figure out the mapping from the keyboard character to font char-
acter. When using Windows, you can find what glyphs to use for characters by
using the “Character Map” application (usually found under Programs>Ac-
cessoires, or run charmap.exe in a DOS cmd-window).

F.6. Labelling your map

Of course it is also possible to label objects in WMS. Next we will show how to
add name labels to the airports:

Task 11: Put a LABELITEM object before the existing CLASS definition of air-
ports.

Then put the LABEL code inside the existing CLASS object.
It should end up looking like listing 7.

Listing 7: filefragments/airportlabels.txt
LABELITEM "NameEnglis" #attribute to use
CLASS
NAME "airports"
STYLE
SYMBOL "airport sym"
SIZE 22
COLOR 0 0 O
END #style
LABEL
COLOR 0 0 O
TYPE TRUETYPE
FONT "arial"
MINSIZE 6
MAXSIZE 12
POSITION AUTO
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PARTIALS FALSE
BUFFER 4
END #label
END #class

With LABELITEM you define which column in the attribute table of your shape-
file has to be used for labelling. In the CLASS object you insert one (or more)
LABEL objects to define how the text labels should be rendered:

*+ COLOR to draw the text in.

» TYPE of the font to use.

+ FONT alias as defined in the FONTSET to use for labelling.

* MINSIZE tells which minimum font size to use when scaling the text.

* MAXSIZE tells which maximum font size to use when scaling the text.

* POSITION: Where to position the label text in relation to the label points.
The value is a combination of vertical and horizontal positions. You have the
following choices for vertical alignment: C for centre, U for upper, and L for
lower. For horizontal alignment you have the following choices: C for centre,
L for left, and R for right. So, to align the label text to the centre you'd use
the value “CC” (centre—centre). Or if you'd like it to be on the lower left, you'd
use “LL”. Another way is to let MapServer decide the best position for your
labels. For this you use the value AUTO.

* PARTIALS: Tells MapServer whether to generate incomplete label texts or
not, e.g., when the label would cross the edge of the map, or if it overlaps a
label already placed. The default is not to generate fragments of a label text
(PARTIALS FALSE).

* BUFFER of 4 (pixels) means that no label will be drawn if another label
already is within four pixels distance.

F.7. Creating a legend

For a better understanding of your map it is necessary to add a legend in your
map where the symbols you used are listed and named:

Task 12: Create MapServer code for the legend as shown in listing 8.

Put it in the MAP object, directly under it (in the hierarchy, so on the same
level as the LAYERS).

Listing 8: filefragments/legend.txt
LEGEND
KEYSIZE 16 12
LABEL
COLOR 0 0 0
TYPE TRUETYPE
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FONT "arial"
SIZE 12
END #label
STATUS EMBED
POSITION UR
END #legend

The LEGEND object defines the look and placement of the legend drawing:

+ KEYSIZE sets the size (in pixels) of the symbol key boxes

» LABEL set the type, the size and the color of the font you want to use for la-
beling the symbol keys (see description of LABEL above).

+ STATUS EMBED means that the legend is embedded into the map image

* POSITION sets the place within the map image. In our case on the top-right
side (U=upper, R=right, see POSITION described above).

F.8. Creating a scale bar

A scale bar shows the user the scale of the current map:

Task 13: Create MapServer code for the scale bar as shown in listing 9.

Put it in the MAP object, directly under it in the hierarchy (so on the same
level as the LEGEND).

Listing 9: filefragments/scalebar.txt
SCALEBAR
IMAGECOLOR 255 255 255
LABEL
COLOR 0 0 0
TYPE TRUETYPE
FONT "arial"
SIZE 8
END
STYLE 1
SIZE 150 2
COLOR 0 0 0
UNITS KILOMETERS
INTERVALS 2
TRANSPARENT FALSE
STATUS EMBED
POSITION LR
END #scalebar
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The SCALEBAR object parameters are:

* IMAGECOLOR defines the colour of the scalebar background

* LABEL you set the label options of the scale bar

» STYLE chooses the scale bar style. Valid styles are 0 and 1.

» SIZE is width and height in pixels

* UNITS define the output units of your scale bar (meters, kilometers, miles)

* The INTERVALS parameter defines in what number of intervals to break the
scale bar into.

* TRANSPARENT sets the background transparency

+« STATUS EMBED means that the scale bar is embedded in the map image

+ POSITION is in this case is the lower left side (see above)

Here ends the exercise...
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G. Serving data as an OGC Web Map Service
Establishing WMS with Geoserver

Version 1.0 - September 18, 2012

G.1. Open Standards data dissemination: using GeoServer WMS

Key points

In this exercise you will learn how to set up the software GeoServer as a Web
Map Service using the Open Geospatial Consortium’s OWS standards.

Note that this exercise assumes you are using the OSGEO LIVE system, and
that you have previously done the exercise “Creating data in a desktop GIS
using QGIS”.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the

copyright holder.
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G.1. Open Standards data dissemination: using GeoServer WMS

GeoServer is a service: That means that it acts as a background application,
listening for requests on the web. You configure it using a series of web pages.
It is installed on the OSGEO Live DVD, but the service has to be started up first
in order to work:

x | GeoServer: Welcome x |

|usemame |mm Remember me L | @ Login

Task 1: In the Xubuntu menu, choose Geospatial > Web Services > Start
GeoServer.

The server starts up and a browser window is opened to show the connection
to the service, at the URL http://localhost:8082/geoserver/web

This is the “public” interface, in order to set up the services you will have to
login. Fill in the username (*fadmin”) and password (“‘geoserver”) and click the
login button. The administrator pages are loaded.

GeoServer (http://openserver.org) is an open source software server written in
Java. Designed for interoperability, it publishes data from any major spatial
data source using open standards. Being a community-driven project,
GeoServer is developed, tested, and supported by a diverse group of individu-
als and organizations from around the world. GeoServer is the reference imple-
mentation of the Open Geospatial Consortium (OGC) WebFeature Service
(WFS) and WebCoverage Service (WCS) standards, as well as a high perfor-
mance certified compliant Web Map Service (WMS).

GeoServer uses a fairly elaborate setup: There are several Workspaces, that
each can hold one or more DataStores. These connect the service to various
datastores, either simple ones like vector- and raster files, or more complicated
ones like spatialdatabases or other OGC services. Each datastore can in turn
contain one or more Layers.

B Logout

et~ GeoServer

Abowt & Statuy A

Hill G wbeer. Blcrg Service Capabiitias
ety
Dot

T GasrSerser BSTance & nmning werson LA-REE. Far more avkeraton pleges WFS
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Task 2: We will use an existing Workspace, the default one called “it.geosolu-
tions”. In the Data menu, on the left side of the screen, click the Stores icon or
name.

Now click the rdd New store icon. From the list of datastores, choose the on
called “shapefile - ESRI (tm) Shapefiles (*.shp)”.

Now fill in the dialog: For the Shapefile location, you can use the Browse...
button to navigate to the shapefile you created earlier in QGIS [alternatively,
you can use the pre-made one at our website]. Click the Save button.

Now click in the data menu (left side of screen) on the Layers item. In the next
screen, choose the Add new Resource item.

From the list choose it.geosolutions:myRoutes, and in the list of layers
that is shown next, click on the Publish link next to the myRoutes layers
(should be the only one to choose from).

Now you can edit the Layer properties. Most fields should have been filled in
correctly by default. Check if the projection is set correctly (to EPSG:3857 or
EPSG:900913). Now fill in both the Native Bounding Box and Lat/Lon Bound-
ing Box by clicking the compute from data links under them. Then click the
Save button.

Now you can test the Layer publishing by choosing Layer Preview in the Data
menu (left side of screen). There are many tests here, the most easy being to
click on the OpenLayers link.

Now your data is available for anyone on the internet that connects to one of
the webservices that the GeoServer offers.



Published in: M. Jobst (ed), Service-Oriented Mapping 2012, Section VII, chapters B-1 & K-L, pages 531-592 & 603-613.

JOBSTMedia Verlag, Vienna (Austria), 2012. ISBN 978-3-9502039-2-3.

578 Serving data as an OGC Web Map Service: Establishing WMS with Geoserver

& Ahout GeoServes

Data
j: Layor Prou
Workspaces
| Shores
N Layers
@ Layer Groups

o e
Sarvices

B wrs

b wes

b ey
Settings

§ Cicha
@ Caowenache
B

[ #4 Coveinge Ascina

Sacurity

B usen

New Layer chooser

|

| Choose: Qe |

IL I ROULES

Fig. G.1: Geoserver’s basic store info

Bounding Boxes
Native Bounding Box
Min X Min ¥

Basic Store info
workspace *
itl;ll:u::llllJnrnd
Dats mu- Wamas *
DeEcription o
e wialing Foute
& Enabled

Connection Farameters
Shapafile location *

i mh, iy Aoutes ik | Brriese
CBF charset
SO-ER5- 1 d

& crests spatisl mdex i mgmng outdated
Ltse Ty mapped buffers

& Cache and reuse memory maps

Max X Max Y

[252.330.933  |6.252,893.722

Compute from data

Lat/Lon Bounding Box
Min X Min Y

254,125.408 6,254,154.865

Max X MaxY

Cc:v]ﬁce from native bounds

Fig. G.2: Input of the Bounding Box

[‘,\ ety fcutes FiyFoutss R ML AL | Sk iy -

Fig. G.3: Layer selection



Published in: M. Jobst (ed), Service-Oriented Mapping 2012, Section VI, chapters B-lI & K-L, pages 531-592 & 603-613.
JOBSTMedia Verlag, Vienna (Austria), 2012. ISBN 978-3-9502039-2-3.

Barend Kébben

H. Web Map Services in a web client:
Mapserver WMS in OpenLayers

Version 3.9 - September 17, 2012

H.1. The OpenLayers API

H.2. Making an OpenLayers viewer for a WMS

H.3. OpenlLayers: Adding layers
H.3.1. Adding Thailand WMS layers to the map
H.3.2. Enhancing the layout
H.3.3. Adding the legend

H.4. Querying attributes from WMS layers

Key points

This is a reference for the use of OpenLayers, a JavaScript Library for web
mapping. In this exercise we will us it to create a web page that gives youa

ccess to Web Map Services, including the Thailand WMS you built in earlier
exercises. You will learn how to:

1. Use the OpenLayers library in a web page;
Make a simple map using a WMS,;

Add some layout and controls to it;

Add your own Thailand WMS data to it.
Query the WMS layers for attributes

oo

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-

ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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H.1. The OpenLayers API

OpenLayers makes it easy to put a dynamic map in any web page. It can dis-
play map tiles and markers loaded from any source.

Note: OpenlLayers is a pure JavaScript library for displaying map data in most
modern web browsers, with no server-side dependencies. OpenlLayers imple-
ments a JavaScript APl (Application Programming Interface) for building rich
web-based geographic applications, similar to the Google Maps, with one im-
portant difference: OpenlLayers is Free Software, developed for and by the
Open Source software community based at
http://openlayers.org/. OpenLayers is written in ob-
ject-oriented JavaScript, using components from
Prototype.js and the Rico library. In this exercise,
we will only show the basic building blocks, and
how to employ them. Those wanting to go further,
should check out the development pages and the
examples at the website.

The latest version of the OpenlLayers script library
is always available on the OpenLayers website.
You can “install’ the API by including a link to the
Javascript files in your own HTML web-pages and
then call the methods and properties of the library
using simple JavaScript functions. Using the Open-
layers APl is done by creating webpages (using
HTML) that include Javascript script; this code
makes calls to the APl methods to create the nec-
essary map object and connect that to an HTML
placeholder. Mostly we use an HTML <div> ele- [T
ment as a placeholder. L !

My Webpage

S0Twe CONTENTt

The OpenLayers API has two concepts which are
important to understand in order to build your first
map: Map, and Layer. An OpenlLayers Map stores
information about the default projection, extents,
units, and so on of the map. Inside the map, data is displayed via Layers. A
Layer is a data source — information about how OpenlLayers should request
data and display it. We then uses the methods and properties of the API to
change the content and behaviour of the map. In practice, all this means typing
(and/or copying) HTML and JavaScript code.
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H.2. Making an OpenLayers viewer for a WMS

In listing 1 you see the most basic example of using OpenLayers with a sample
WMS.

Task 1: Create an HTML page with the content of listing 1 and save it as a
wms.html. You can type the code, but it is easier to copy it from the file we
stored in the filefragments folder. Make sure you save this file as a new file
with the extension .html, not .html.txt!). View the result in the web browser.

Listing 1: wms.html.txt

<!DOCTYPE html><html> html document starts
<head> html header starts
<script
src="http://localhost/openlayers/Openlayers.js"></script> load
the API
<script type="text/javascript”> script for our map
var myMap, myWMSBaselayer; define map and layer object
var myCenter = new Openlayers.LonLat (0,0); define center long, lat
function
init(){ function triggered on locad
myMap = new Openlayers.Map ("mapDiv") ; create map object
myWMSBaselayer = new Openlayers.Layer.WMS ( create WMS
layer

"world WMS", title of OL layer

"http://geoserver.itc.nl/cgi-bin/mapserv.exe?
map=D:/Inetpub/—

geoserver/mapserver/config world.map&"”, baseURL
{layers: "world"} WMS layer(s) to load
) i
myMap.addLayers ( [mylWMSBaselLayer] ) ; add layers to map
myMap.setCenter (myCenter, 2) ; map at lon-lat(0,0) zoom 2
} end of init script
</script>
</head>
<body onload="init()"> run init script
<div id="mapDiv" map placeholder
style="width:800px; height:400px;"></div> placeholder style
</body></html>

The result should look like figure H.1, showing the simple WMS service of
world countries, zoomed out at the world’s center (longitude = 0, latitude = 0).
You can set up the WMS map to start at any place on the globe, by changing
the coordinates that were used in the myCenter variable:

var myCenter = new Openlayers.LonLat(0,0) ;
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Fig. H.1: Result of loading listing 1.

Note that the order is longitude -latitude! This is done to mimic the order X-Y
when using projected (cartesian) systems. In order to find which coordinates to
use to zoom to, it would be nice to have a knowledge of where (in coordinates)
you are in the map. For that we will include a coordinate readout line and a
scale bar:

Task 2: Add the following line in the script just before the line with the
myMap.SetCenter command:

myMap.addControl (new Openlayers.Control.MousePosition() )
myMap.addControl (new OpenlLayers.Control.Scaleline())

Save the file and try out the result in the browser.

The coordinates you see are longitude and latitude in a degrees on the
spherical WGS84 datum. The is officially standardized as EPSG code 4326.
You can change the line myMap. setCenter (myCenter, 1) to set an alternative
starting point (change myCenter variable) and zoom (from 0-18) for the map.

Task 3: Try setting up the map in such a way, that it starts zoomed in on Thai-
land.

H.3. OpenLayers: Adding layers

Open Layers allows the use of many layers in the same client, coming from
different sources:

* OGC Web Map Services (WMS) & Web Feature Services (\WFS);

« Other open geo-webservices (e.g., OpenStreetMap, GeoRSS, NASA World-
Wind);

+ Commercial geo-webservices like Google Maps, Yahoo, Microsoft Bing
Maps, MultiMap;

» Client-side data such as GML, KML, marker-layers, drawing layers, text lay-
ers and others.

You define layers using the OpenlLayers.Layer object:
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myNewLayer = Openlayers.Layer.layerType ( nameOfLayer, {listOfOp-
tions} );

The layerType defines what server- or client side layer is to be used.
{1listofoptions} is an array of name:value pairs that are used to add a multi-
tude of special settings. Depending on the layerType, zero or more options
are required. We saw for example in the WMS layerType we used in sec-
tion H.2 that a few additional options were needed. E.g. the baseUrL, that de-
termines where to find the WMS, and layers, a string that will be used to ask
one or more layers from the WMS.

There is an important difference between what OpenLayers calls Base Layers
and Overlays. There is always at least one base layer needed. It's the one that
determines the projection, extent and units of the map. You can define several
base layers if they share the same parameters (e.g., several layers of one
WMS, or the various types of Google maps), but the user can always have only
one turned on, the choice will be made using a radio-button list. Overlays are
layers that can be fitted on top of the base layer. Because they can be trans-
parent, many overlays can be used, and they each can individually be turned
on or off (using a checkbox list). By default, new raster layers will become base
layers, unless you have made sure they are transparent, in that case they can
be overlays. Most vector layers are by default Overlays.

H.3.1. Adding Thailand WMS layers to the map

Now let us add a layer using the Thailand WMS we made earlier in the
MapServer exercises:

Task 4: First find the line that reads:

var myMap, myWMSBaseLayer;
and change it to:

var myMap, myWMSBaseLayer, railroadlLayer;

This adds a necessary variable to hold the data for the WMS layer. Add the code
below just after the layer definition you made earlier (for the WMS world map):
railroadlLayer = new Openlayers.Layer.WMS ("Thailand RailRoad",
"<CGIPATH>?map=<NETPATH>/config.map&", {layers: "railroad"”,
transparent: "true", format: "image/png"} );

Refer to the earlier MapServer exercises, to know how to substitute the <CGl-
PATH> and the <NETPATH> for the proper values for your set-up!

Now look for the line in the code that reads:

myMap.addLayer ( [myWMSBaselLayer] ) ;

To include the new layer in the map object change it to:
myMap.addLayers ( [myWMSBaseLayer, railroadlayer]):;
Try it out in the browser...!




Published in: M. Jobst (ed), Service-Oriented Mapping 2012, Section VI, chapters B-lI & K-L, pages 531-592 & 603-613.
JOBSTMedia Verlag, Vienna (Austria), 2012. ISBN 978-3-9502039-2-3.

584 Web Map Services in a web client: Mapserver WMS in OpenlLayers

There is still one annoying problem: The legend and scale bar you defined in
the earlier WMS exercise will be shown several times within the map. This is
because OpenlLayers uses a tiling mechanism to subdivide the WMS output in
many small tiles. Each of these tiles will have a legend and scale bar, because
you did set the LEGEND and SCALEBAR objects in the configuration file to
STATUS EMBED.

Task 5: Open the config.map file and set the LEGEND and SCALEBAR ob-
jects to STATUS ON.

Try viewing wms.html in the browser again.

The legend (and scale bar) will now disappear, but we will make the legend ap-
pear again in a different way further on.

Task 6: Now add two more layers of the Thailand WMS: forest and airports.
You should be able to figure out how to do that based on the previous tasks...

Now we have more than one layer, we want to control which of those are
shown in our map. For that, add the line :

myMap.addControl (new Openlayers.Control.LayerSwitcher());
after the other addControl statements. Check the result.

A new control should have been added to the map: next to the pan and zoom
tools, there now should be a little + icon in the upper-right corner. Clicking it will
reveal a Layer Control, which can be used to switch layers on and off.

H.3.2. Enhancing the layout

In order to have a place to put the legend in, we will make a more sensible lay-
out than the one we had earlier. You can change the layout by setting the prop-
erties of the separate place-holders in HTML. Many HTML elements can be
used as place-holders, one of the most simple to use is the <div> element we
used earlier.

Task 7: Change the line:

style="width: 800px; height: 400px; "></div>
to:
style="position: absolute; left: 5px; top: 5px; width: 400px;

height: 600px; - overflow: hidden; border: 1px solid blue;
"></div>

The style properties are expressed using CSS, Cascading Style Sheets, a
styling language standardised by the W3C, the World Wide Web Consortium.
The meaning of the properties used is:
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« position: this lets you define positioning absolute or relative to other divs.

« left & top: the (absolute) location with respect to the upper left corner of the
window

+ width & height: the size of the element (in pixels)

« overflow: if the content is larger than fits the div, it will not be shown if this is
set to hidden. Other settings are visible (will overflow), scroll (will make
scrollbars) and auto (let browser decide).

* border: the border look (width, type and colour). You can also set the fill in a
similar way.

H.3.3. Adding the legend

Now add another section to the layout that will hold the legend for the Thailand
WMS layers:

Task 8: Add a second <div> element for the legend:

<div id="legend" style="position:absolute; width:250px;
height:200px; left: —

420px; top: 5px; overflow: auto; border: 1px solid red; ">
<img src="<CGIPATH>?
map=<NETPATH>/config.map&SERVICE=WMS &REQUEST= —
GetLegendGraphi c&VERSION=1.1.1&FORMAT=image/png&LAYER=forest">
<br/>

</div>

This should result in the layer legend being shown in the legend div. Now add
the legends for the other layers in a similar fashion within the same div.

5 | ™ forest Reamrue
g ok iwmal Fard:

H ol goeesd
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Fig. H.2: After addition of the legend and query divs.
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The src parameter of the img tag issues a new OGC WMS request called
GetLegendGraphic. This retrieves the legend of the LAYER requested as an
image in the FORMAT requested from the WMS.

H.4. Querying attributes from WMS layers

Above we issued an additional WMS GetLegendGraphic request to get the leg-
end. We can use a similar mechanism to retrieve attribute data of the maps by
issuing the OGC GetFeaturelnfo request. This involves some more work, be-
cause the result will be some arbitrary content that will arrive after an unknown
amount of time. For this we will use something called Asynchronous
JavaScript.

First we have to prepare MapServer to actually be setup to respond to the re-
quest in a way the OpenlLayers script can handle.

Task 9: Edit the config.map file. In each LAYER object you want to query, put
the lines:

TOLERANCE 4
TOLERANCEUNITS pixels

In each LAYER object's METADATA put the extra line:

"wms_include items" "all"

In each CLASS object put the extra line:
TEMPLATE "empty"

This “TOLERANCE” and “TOLERANCEUNITS” lines will make sure that an ob-
ject is considered clicked upon, even if you are up to 4 pixels off. You will prob-
ably want to change these values later, to refine the results per layer.

The “wms_include_items” tells MapServer to show all attributes it has avail-
able. You can change it to a comma-delimited list of attribute names if you want
to limit the output.

The “TEMPLATE” line is needed for GetFeaturelnfo to work, but it does not
have to point to an actual template document (that is why we put a “dummy”
value in there). If you want to use a real template, to nicely format the GetFea-
turelnfo output, you let it point to an actual template HTML file (see the
Mapserver documentation for more information).

Task 10: Now edit your html file: Put the code in listing 2 just at the end of the
init() script (after the myMap.setCenter() line). «
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Listing 2: filefragments/getFeaturelnfo.txt

getFeatureInfoCntrl = new Openlayers.Control.WMSGetFeaturelnfo-
( { infoFormat:"text/plain” } );:
getFeatureInfoCntrl.events.register—

("getfeatureinfo", this, showQueryResult) ;

myMap.addControl (getFeatureInfoCntrl) ;
getFeatureInfoCntrl.activate();

The first statement creates a new Control of the “WMSGetFeature-Info” type.
This will fire a GetFeaturelnfo request to the WMS services associated with the
map. You can override the default request parameters by providing them in the
{options} object. Here we leave all of them at default except the infoFormat:
"text/plain". This request the output to be in plain text, instead of the de-
fault of GML.

The next line registers a so-called event-listener, that will be triggered every
time anyone makes a “click” in the map object. This will send the GetFeature-
Info request URL to the server and point to a callback function named show-
QueryResult. This function will be triggered later, if and when something
comes back. We call this asynchronous processing. The last two lines add the
control to the map and activate the event listener.

Now you will have to create the call-back function:

Task 11 : Put the code below at the end of the script (after the ending } of the
init function, but before the ending tag </script>).

function showQueryResult(evt) { alert(evt.text); }

Test the result in a web browser. Do not open the file from your file—system
(c\ or m:\), but always from the actual web site, e.g. hitp://itcnt07.itc.nl/~ or
http://localhost/. This is the only way to properly test your web site!

The reason is that some browsers (notably FireFox) are strict on so-called
JavaScript cross—domain security, meaning it won’t run JavaScript that is not
coming from the same server as the html. And from the browser viewpoint,
a file coming from the file system is from another domain than one from
http://localhost/, even if both addresses point to the same file...!

Showing the GetFeaturelnfo results in alertboxes, like we do here, is a simple,
but not a very good solution. The way it works and looks will be different on
various web browsers and operating systems. Let’s make the results appear in
our map interface instead:
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Task 12 : Edit your html file: Add a third element to the HTML layout as a
placeholder for the query results:

<div id="queryresultsDiv" style="position: absolute; width:
250px; height: — 395px; left: 420px; top: 210px; overflow:
auto; border: lpx solid red;">

</div>

Now change the showQueryResults function to:

function showQueryResult (evt) —
{ queryresultsDiv.innerHTML = evt.text; }

Now the results should be shown nicely in the results box. You will notice that
especially at small scales, many elements will be found. You can manipulate
this by editing the TOLERANCE values in the config.map files. Try to get sensi-
ble values for the various LAYERS, and keep in mind their different types (poly-
gon, line and point data)...!
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I. WMS in a webmap page:
Combining WMS and OpenStreetMap

Version 3.9 - September 17, 2012

I.1. OpenLayers: adding layers

1.1.1. Combining Thailand WMS layers with an OpenStreetMap
background

Key points

In this exercise we will us it to create a web page that gives you access to
OpenStreetMap, an Open Data map service, and overlay that with your own
Web Map Services. You will learn how to:

1. Use the OpenLayers library in a web page;
2. Make a simple map using the OpenStreetMap background;
3. Add your own WMS data to it.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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1.1. OpenlLayers: Adding layers

Open Layers allows the use of many layers in the same client, coming from
different sources:

* OGC Web Map Services (WMS) & Web Feature Services \WFS);

« Other open geo-webservices (e.g., OpenStreetMap, GeoRSS, NASA World-
Wind);

+ Commercial geo-webservices like Google Maps, Yahoo, Microsoft Bing
Maps, MultiMap;

» Client-side data such as GML, KML, marker-layers, drawing layers, text lay-
ers and others.

You define layers using the OpenlLayers.Layer object:

myNewLayer = Openlayers.Layer.layerType ( nameOflayer, -
{listOfOptions} )

The 1layerType defines what server— or client-side layer is to be used.
{1listofoptions} is an array of name:value pairs that are used to add a multi-
tude of special settings. Depending on the layerType, zero or more options
are required. We saw for example in the WMS layerType we used in section 2
that a few additional options were needed. E.g. the baseURL, that determines
where to find the WMS, and layers, a string that will be usedt o ask one or
more layers from the WMS.

There is an important difference between what OpenLayers calls Base Layers
and Overlays. There is always at least one base layer needed. It's the one that
determines the projection, extent and units of the map. You can define several
base layers if they share the same parameters (e.g., several layers of one
WMS, or the various types of Google maps), but the user can always have only
one turned on, the choice will be made using a radio-button list. Overlays are
layers that can be fitted on top of the base layer. Because they can be trans-
parent, many overlays can be used, and they each can individually be turned
on or off (using a checkbox list). By default, new raster layers will become base
layers, unless you have made sure they are transparent, in that case they can
be overlays. Most vector layers are by default Overlays.

1.1.1. Combining Thailand WMS layers with an OpenStreetMap background

Now let us try to use the OpenStreetMap as a background layer for the Thai-
land WMS we made earlier in the MapServer exercises:
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Task 1: First find the line that reads:

var myMap, myWMSBaselayer, forestlayer, railroadLayer,
airportslLayer ;
and change it to:

var myMap, myOSMLayer, forestlLayer, railroadLayer,
airportslLayer ;

Next, find the lines that read:

myMap.addLayers ( [myWMSBaseLayer, forestlayer, railroadLayer,
airportsLayer]) ;
To change to the OSM as a base layer, change it to:

myMap.addLayers ( [myOSMLayer, forestlayer, railroadLayer,
airportslLayer ]);
Now look for the line in the code that reads:

myWMSBaselLayer = new OpenlLayers.Layer.WMS
( <...more code here...> );

and change it to:

myOSMLayer = new Openlayers.Layer.O0OSM("OpenStreetMap") ;
Try it in the browser.

Note that the result is not what you might have expected: The map is no
longer zoomed in to the correct location! But even if you zoom and pan back
to Thailand, no Thailand WMS layers are present. Instead you see so-called
“pink tiles”, which are OpenLayer’s way of indicating it has trouble with one or
more layers...!

Your initial try to combine OSM and WMS failed, because it is not so straight-
forward as it may seem. The reason for that is the difference in map projection
of the layers. The basic OSM layer is using the Google Mercator projection
(EPSG code 3857 or 900913), as explained in the exercise where you loaded
the OSM separately. But the Thailand WMS data is in degrees longitude—lati-
tude on the WGS84 datum (EPSG code 4326). We can not influence the OSM
projection, but a proper WMS should be able to serve its data in any projection
that the software supports. However, we do have to set up the WMS to allow
that, which is very simple actually:

Task 2: In the WMS configuration file (config.map) look for the WEB/
METADATA object and find the line

"ows_srs" "EPSG:4326 " #latlon
and add the Google Mercator to the list of allowed projections, thus:

"ows_ srs" "EPSG:4326 EPSG:3857" #latlon,google
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Next we have to make sure OpenLayers makes the proper request for the re—
projection to happen:

Task 3: In the html file change the simple map object definition:
myMap = new Openlayers.Map ("mapDiv") ;
to the more detailed:

myMap = new Openlayers.Map ("mapDiv", {projection:"EPSG:3857"});
What we do here is tell OpenLayers explicitly to use the Google Mercator pro-

jection. The OSM layer “knew” about this already, but now also the WWMS
layer will be told to behave!

Now try loading the map once again in the browser. You now should have
more success.

The only small problem left is that the map initially starts zoomed into the
wrong place. This is because the coordinates we provided for the center of
Thailand were in degrees longitude-latitude. And now that we use the Google-
Mercator projection, we need to provide it in meter X-Y coordinates:

Task 4: Change the myMap.getCenter coordinates and the zoom factor to
have the map initially zoomed in on Thailand. Note that the function used to
set the coordinates should remain the same, although its name is now a bit
confusing and contra-dictionary.
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J. Introduction to SQL,
the Structured Query Language

Version 1.0 — Ocfober 10th, 2012

J.1. A SQL explanation

J.2. Dealing with database tables
J.3. Relationships

J.4. The SELECT statement

J.5. The INSERT statement

J.6. The DELETE statement

J.7. Further readings

Key points

This document is intended to serve as a quick introduction to the Structured
Query Language (SQL). This language is the central tool to access database
content and extract information that is stored in tables and relations most effi-
ciently. Databases are one main component in spatial data infrastructures and

feed material for map production (beside the direct access to data via geo
web services).

#l © Rescarch Group Cartography, Department for Geodesy and Geoinformation, Vienna
University of Technology. This document may be freely reproduced for educational use. It may not be edited or
translated without the consent of the copyright holder.
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J.1. A SQL explanation

SQL, which is an abbreviation for Structured Query Language, is a language to
request data from a database, to add, update, or remove data within a data-
base, or to manipulate the metadata of the database.

Instructions are given in the form of statements, consisting of a specific SQL
statement and additional parameters and operands that apply to that state-
ment. SQL statements and their modifiers are based upon official SQL stand-
ards and certain extensions to that each database provider implements. Com-
monly used statements are grouped into the following categories:

Data Query Language (DQL)

« SELECT - Used to retrieve certain records from one or more tables.

Data Manipulation Language (DML)

¢ INSERT - Used to create a record.
+ UPDATE - Used to change certain records.
« DELETE - Used to delete certain records.

Data Definition Language (DDL)

« CREATE - Used to create a new table, a view of a table, or other object in
database.

* ALTER - Used to modify an existing database object, such as a table.

* DROP - Used to delete an entire table, a view of a table or other object in the
database.

Data Control Language (DCL)

* GRANT - Used to give a privilege to someone.
« REVOKE - Used to take back privileges granted to someone.

J.2. Dealing with database tables

Before learning SQL, relational databases have several concepts that are im-
portant to learn first. Databases store the data of an information system. We re-
group data by groups of comparable data (all the employees, all the projects,
all the offices...). For each group of comparable data, we create a table. This
table is specially designed to suit this type of data (its attributes). For instance,
a table named “employee” which stores all the employees would be designed
like the following:
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The storage will look like the following figure.

amgkyae
id_smployes firsiname  Bsimama phonge mal
- Eoee
e Eig BOES SIFEE4T0 hig hessEleompany cam
7 Jokn DOE SIGES4FT |t conglcompany cam
a Linus TORVALDS S38E854272 inus torvalds@company com
4 Jimmy  WALES 938854273 jimmy walescompany, com
& Ly BAGE SAGA54274 iy pagedicompany. com

The data stored in a table is called entities. As a table is usually represented as
an array, the data attributes (first name, last name...) are called columns and
the records (the employees) are called rows. 1d employee is a database spe-
cific technical identifier called a primary key. It is used to link the entities from a
table to another. To do so, it must be unique for each row. A primary key is
usually underlined. Any unique attribute (for instance, the mail) or group of at-
tributes (for instance, the first name and last name) can be the table primary
key but it is recommended to use an additional technical id (id_employee) for

primary key.
emplayes
t
18_employes frstname bstname  phane Ll prose
L)

Big BOES QEEENAIT | Dig BosSEB LMy 0om _progect namse | oreated on ended_on mansgar

) SRS o s 3 1
¥ oo Lt - b cathusto, R skl 1 Google (19980008 KULL 5
1 Linus TORVALDS SeiSd273 linus onvakds@c ompany. com z Linux 190101 WULL q
4 Jimmy WIALES QEEEIAATI [immy wale sl ompany.com Whipeadal2o01-01-01 | RULL 4
] Larry FAGE SIEHI42TA 2Ty papeficompany com

If we add another table called “project”, we can explain the use of a foreign key.
id project is the primary key of the project table and manager is a foreign
key. A foreign key is a technical id which is equal to one of the primary keys
stored in another table (here, the employee table). Doing this, the Google pro-
ject is linked to the employee Larry PAGE. This link is called a relationship. A
foreign key is usually preceded by a sharp (#). Note that several projects can
point to a same manager so an employee can be the manager of several pro-
jects.
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If we want to create, not a single link, but multiple links, we have to create a
junction table. A junction table is a table that isn't used to store data but links
the entities of other tables. The following figure shows a table called members
which links employees to project.

LLyl=l ] Arogect
I _empigyes an integer |E_RICHEET | 3m iribmpe
membars
Epdips a5l '!ull‘l H © Nara [ers. name a Fnng of Characlers
2id_employes an inkeger
Iaziname B sirng of chara ters created_on a date
#id_projee] | an inbeger
phAgna 10 Al enoed_on A oAk
mail B3l ng ol charadters ® manager | an irbentpesr

An employee can be associated to several projects (John DOE with Google
and Wikipedia) and a project can be associated to several employees (Wikipe-
dia with Jimmy, John and Jenny), which is impossible with just a foreign key. A
junction table hasn't its own primary key. Its primary key is the couple of foreign
keys, as this couple is unique. A junction table can link more than two entity
tables by containing more columns.

J.3. Relationships

Several various relationships can be defined within a relational database. So
let's list the different types of relationships:

¢ Oneto one,
* One to many (for instance, the manager of a project),
* Many to many (for instance, the members of the projects).

For each type of relationships, there is a way to link the entities:

* One to many relationship: create a foreign key from an entity table to the
other,

+ Many to many relationship: create a junction table,

* One to one relationship: just merge the two tables.

Now you know how to design a database schema and to put the data of your
information system into it. The Data Query Language is used to extract data
from the database. It doesn't modify any data in the database. It describes only
one query: SELECT.
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J.4. The SELECT statement

The following figure shows an exhaustive overview on the syntax of the
SELECT query.

SELECT | ALL  DISTINCT COLDMN mams A5 calias ALL DISTINGT COLTMN nass A% cplinm
FROM -Cable BS cmlims FOLL LEFT| K OOTER  INWER) JOIN —table- ON - EXpEsasion
takle A% caliar FUOLL  LEFT RISHT SOTER DEER JOIN bable 0N -wspeeszica
WHERE - predicate #iND OF, predicate
GROUT BY - COLT naam SOLFH nane
HEAUTRG dicate AND OR cpredicate
ORDER BY (O0LIMH masa: | ASC) DESO COLIMH ramsc | RS0, DESE

FETCH FIRET cocunt: BOWS OHLY 7

In order to explain the commands, following figures show the given table “re-
union”. The left figure shows the table structure, the right figure shows the table
with some test data.

A
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rwnad  TAMIBT Hiarcig Wi npariin plan [he purgs: R 1T A AT H + NS HIEE
dabw JRIE 1 Fiogriss Wial v hawi e 1 DELSREWODND X 13 SERl . 15ETR
har e 1 hange  'Whod we merrlie changs in thes progerd R 1 NNERCS A A 'h] AFTR SFAFFRA
dnmten HTECER d Fggarial o Piaggndciion of the proja i o 0 WE2MEEED W =

el HIECER 5 Juporing Saphanwinr 1o e rae beg nrer. B 1 HELHEOEN0 6D H T STHE

alluul BUE [ Leswming & s polsge sadin Fas bosn l1elalkd. B | NELG1E00N 1N " pizvn: .|

J.4.1. A first query: a simple SELECT statement

The following command in SQL will derive all content from the table “reunion”:

SELECT *
FROM reunion;

The result looks like this:

|
lid_reunion |name |descripnion Iprioricy |planned |date [ lduranion |id_sffice |pdf_report |
| 1 | 1 1 | | | | 1 |
1 1Planning IWe need to plan the project. 5% 1L 12008-03-24 110:30:00 |60 135 148644 546348 |
12 IProgress |Uhat we have done. Ic 1L 12008-05-12 |14:00:00 |30 113 19862 . 15676 |
13 IChange |Mhat we need to change in the project. 1B 1L 12008-06-03 19:30:00 |90 141 134876 4846545 |
14 |Presentation |Presentation of the project. 1D 10 |2008-09-11 |15:30:00 |120 127 I1NuLL |
15 IReporting |Explanstion te the new beginner. 1B 1L 12009-03-15 114:00:00 |60 17 119739...37718 |
16 ILearning |4 new software wersion has heen inscalled. |B 1L 12009-09-21 |16:00:00 120 111 1765278, 37528 |

|

The graphical form of the result depends on the client application. It can be re-
turned as a text output (backend), a HTML page (thin client) etc... The state-
ments, queries, clauses (SELECT, FROM..)), instructions and operators are not
case sensitive but they are commonly written in uppercase for readability.

The SELECT and FROM clauses are the two required clauses of a SELECT
query:

« FROM : list the tables the query uses to return the data.
» SELECT : list the data to return.
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J.4.2. WHERE clause

The WHERE clause doesn't influence the columns that are returned by the
query. But it influences the rows. It filters the rows applying specific
“predicates” on it. A “predicate” specifies conditions that can be true or false.
SQL can handle conditions whose result is unknown.

The following query returns the reunions which have a B priority level:

SELECT *
FROM reunion

WHERE reunion.priority = 'B';

| |
1id_revnion |nsume Idescriprion Ipriority |plaxned |date I hour lduration |id office |pdf reporc |
| | | | | | | | | | |
13 IChange |What we need to change in the project 1B s 12008-06-03 |9:30:00 |50 141 134876 4846548 |
[ IReporting IExplanation to the new begimer. 1B 1L 12003-03-1F |14:00:00 |60 17 118785, ..37718 |
16 ILearning 14 new software wersion has been installed. |B 1 12009-05-21 |16:00:00 1120 111 1785278...37528 |
| |

J.4.3. Predicates
Compared to the second operand, the first operand can be :

* equal: =

» different : <>

* lesser: <

* lesserorequal : <=

* greater: >

* greater orequal : >=
The following query returns the reunions which have another priority level
than B:

SELECT *

FROM reunion

WHERE priority <> 'B';
|

|
|
1 | | 1 | | | | | | |
1 | Plarming |We need to plan the projsct. 2 11 12008-03-24 |10:30:00 |60 135 148644, ..846348 |
|
|
|

1z | Progress |That we have done. Ic [E |Z008-08-12 |14:00:00 |30 113 19862, . . 15676
14 |Presentation |Presentation of the project [ 10 12008-09-11 |15:30:00 |120 127 IMULL
|

J.4.4. Operators

The WHERE clause can have several conditions using the operators AND (all
the conditions must be true) and OR (only one condition needs to be true). The
operator OR is inclusive (several conditions can be true). The order of
evaluation can be indicated with brackets. NOT inverts a condition. The
following query returns the reunions which have a B priority level and last more
than an hour or which take place on 2008/05/12:
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SELECT *
FROM reunion
WHERE (priority = 'B' AND NOT duration <= 60) OR DATE = '2008-05-12';

Ipriority Iplanned |date Ihour lduration |id_office |pdf_reporc
| 1 | | | | |

. Ic 1L 12008-05-12 [14:00:00 |30 113 19862. .. 15676
© change in the project. 1B 1L 12008-06-03 [3:30:00 |20 141 134876, .. 4346548 |
sion has been installed. |B 1 |2009-09-21 [16:00:00 |120 [E81 | 785278, . 37528 |
1 1

J.4.5. The FROM clause

The FROM clause defines the tables that are used for the query but it can also
join tables. A JOIN builds a super table with the columns of two tables to be
used for the query. To explain what a join is, we consider two archaic tables
without primary keys nor foreign keys.

We want to associate values from columns of different tables matching values
on a given column in each table. Then we use in most cases “JOIN”.

J.4.6. The FULL OUTER JOIN

A JOIN is made matching a column on a table to a column on the other table.
After a FULL OUTER JOIN, for a given value (red), for a given row with this
value on one table ([ red | 9999 ]), one row is created for each row that
matches on the other table ([ red | OOOOOO ] and [ red | LLLLLL ). If a value
exists in only one table, then a row is created and is completed with NULL
columns.

FROM table 1 FULL OUTER JOIN table 2 ON table 1.common value =
table 2.common value

common_value specific_value_1specific_value_2

red 9995 Q00000
red 9993 LLLLLL
grey BE66 NULL
white 0ooo NULL
purple rrrkd NULL
purple 2222 NULL
black aal= e FFFFFF
green NULL HHHHHH
yellow NULL FFFFFPP

blue NULL RRERRR
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J.5. The INSERT statement

The following figure shows an exhaustive overview on the syntax of the

INSEET INTD -TABLE mame COLME name OO LITHH - sl

VALDES |<valpe alue

SELECT [ALL © DISTINCT COLTNE] mara ALL | DISTINCY COLDME =ams

FROM - table A Alips FULL LEFT RIGHT @ DOTER INEER TOIH ~table: OH “expressios

table ns aliam FULL ~ LEFT | RIGHT OUTER IRNER JOIH -table. O - Expression

WHERE :predicace AFD | 0RO predicace
GROJP BY - COLUME pane COLMEE nam=
HEVING <predicaces HHD i ] pradicace

ORDES. BY COLUME pame s AEC | DEEC COUTEH nam= - (AEC  DESC
LIMIT czapac

The INSERT statement is used to add new records (rows) in a table. For
instance, we want to add a new reunion:

* Its primary key is 7,

¢ [ts name is "Job interview",

* Its description is "Meeting with Mr. SPENCER",

* Its priority is B,

* Its planned,

« |ts date is on October 28, 2009,

¢ |ts houris 18:30:00,

¢ |ts duration is 30,

 |ts office technical id is 23,

* There is no pdf report.

The statement uses the following statement:

INSERT INTO reunion (id reunion, name, description, priority,
planned, DATE, HOUR, duration, id office, pdf report)

VALUES (7, 'Job interview', 'Meeting with Mr. SPENCER', B, 1,
2009-10-28, 18:30:00, 30, 23, NULL);

TEnson
id remisn  mame drscripfon prinsifyplanmed  date e dmatien ¥ id_slfiice pdf roport

1 Flanning Wi read b plan thi projeed A 1 0|02 103000 5] E.3 BG4, AdG38
Z Progmss Wi wa have Jong G T 2003051214000 30 12 SEEZ .. 15578
El Ghange  'What wa e te chengs in Che project B 1 Ne0a 5000 N 41 TG, 458
4 P ricusamtatnon Pracaambataon of the project u] 0 20E0E11sNm 14 X

5 Fraparting Explunation Io the new beginner =] 1 0315 14:00:00 80 7 197937718
B Leaming A mew sobwme wemion has been metalled. B 1 OEETEmDn 14 11 TEGEPE . IFES
7 -t indeed i Plet ey with Wi SPEMCER =] 1 01029133000 30 3

The INTO clause contains the name of the table where the record needs to be
inserted. It can be followed by a list of columns in brackets. The VALUES



Published in: M. Jobst (ed), Service-Oriented Mapping 2012, Section VI, chapters B-lI & K-L, pages 531-592 & 603-613.
JOBSTMedia Verlag, Vienna (Austria), 2012. ISBN 978-3-9502039-2-3.

Markus Jobst 601

clause contains the values to insert in brackets. If the column names are omit-
ted, the VALUES clause must contains as many values as the number of
columns of the table. The values are inserted in the table columns in the same
order that the order in which the columns have been declared in the table. If the
column names are mentioned, there must be as many column names as val-
ues. The values are respectively inserted into the named columns. If a column
in the table is omitted, a NULL value is inserted instead.

J.6. The DELETE statement

The following figure shows an exhaustive overview on the syntax of the
DELETE statement.

DELETE FEOM «<table name:
[WHERE <predicate> [{BND | CR} <predicate>]¥*];

The DELETE statement is used to remove specific rows in a table with condi-
tions. The FROM clause is followed by the table name in which the rows need
to be removed. The WHERE clause contains predicates. If the predicates are
true for an row, this row will be removed. If the predicates are false for all the
rows, the statement do nothing. A DELETE statement without WHERE clause
empties the table.

For example, we want to remove all the reunions that last two hours:

DELETE FROM reunion
WHERE duration = 120;

Further reading

This lecture bases on the wikibook SQL (hitp://en.wikibooks.org/wiki/Struc-
tured_Query_Language, [accessed in October 10th 2012]), which gives a com-
prehensive and easy readable overview on this topic.

Melton, Jim; Alan R Simon (1993). "1.2. What is SQL?". Understanding the New SQL: A
Complete Guide. Morgan Kaufmann. p. 536. ISBN 1-55860-245-3.

Wagner, Michael (2010). SQL/XML:2006 - Evaluierung der Standardkonformitat aus-
gewahlter Datenbanksysteme. Diplomica Verlag. p. 100. ISBN 3-8366-9609-6.

ISO/IEC 9075-11:2008: Information and Definition Schemas (SQL/Schemata). 2008.
p. 1.

DateC. J. with Hugh Darwen: A Guide to the SQL standard : a users guide to the stand-
ard database language SQL, 4th ed., Addison Wesley, USA 1997, ISBN 978-0-201-
96426-4

SQL in Wikipedia, http://en.wikipedia.org/wiki/SQL [accessed in October 10" 2012]
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Task 1: Use SQL statements on a geographical database. Spatiallite offers a
graphical user-interface that allows to create and access a database easily.

The tool “spatialite GUI” can be found on the OSGeo Live system in “data-
bases”.

Following steps give you a first SQL experience:

* Open “spatialite GUI".

» Create a new database.

* Use the operation “load SHP” to import a table from a *.shp file. (In our
case, we have downloaded a dataset called “world_factbk”.)

» Start your first SQL queries in the query window (e.g. like the following).

Request the whole content of the table “world_factbk™:
SELECT * FROM world factbk

Request content that is from continent “Europe”:
SELECT * FROM world factbk
WHERE CONTINENT = 'Europe'

*spatiofile-gui-  [a GUE 1esl fop S0 itarSpatiolsie]
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K. PostGreSQL/PostGIS Satial Databases:
Using PostGIS with pgAdmin and QGIS

Version 2.0 - September 18, 2012

K.1. Introduction to PostGreSQL and PostGIS
K.2. Using pgAdmin to administer PostGreSQL/PostGIS

K.2.1. Using SQL for communication with the database
K.3. Using PostGIS data in QGIS

K.3.1. Showing PostGIS data in QGIS layers

K.3.2. Loading data into PostGIS using QGIS

Key points

This is a short introduction to the database system Post-GreSQL and its spa-
tial extension PostGIS. We will show you the basics of using pgAdmin to set
up and administer PostGIS data, and how to use the desktop client QGIS to
show spatial data in the form of maps as well as how to import data into those
databases. This exercise is NOT an introduction to SQL or database theory.

This exercise also assumes you are working with the OSGEO LIVE system.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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K.1. Introduction to PostGreSQL and PostGIS

In many information systems that use more then a trivial amount of data, a spa-
tial database backend is required, to handle large amounts of data having to be
served to large amounts of users. If the data we are using is spatial in nature,
the PostGIS extension to the object-relational DBMS PostgreSQL is a good
choice.

First, because PostgreSQL is a solid DBMS that has a reasonably gentle learn-
ing curve, yet is wonderfully appropriate for advanced database applications,
and its documentation is very transparent. PostGIS in addition, is the leading
open standards implementation of spatial vector management (and since this
year also for raster data). It enjoys a lively and supportive user/developer com-
munity. The combination of the two is enjoying an ever-growing user base, par-
ticularly in the domain of industrial applications.

PostgreSQL(http://postgresqgl.org) is an object-relational database manage-
ment system (ORDBMS) that is open-source and supports a large part of SQL.
Among other things it enables complex queries, foreign keys, triggers, views,
transactional integrity and has robust multiversion concurrency control. And be-
cause of the liberal license, PostgreSQL can be used, modified, and distributed
by everyone free of charge for any purpose, be it private, commercial, or
academic.

Due to a plug-in architecture it can be extended in many ways: by adding new
datatypes, functions, operators, aggregate functions, index methods and proce-
dural languages. This has been used by developers to create PostGIS: an ex-
tension that allows OGC Simple features objects to be stored in the database.
PostGIS (http:/postgis.refractions.net) includes support for GiST-based
R-Tree spatial indexes, functions for analysis of OGC geometries and functions
for processing of OGC geometries.

K.2. Using pgAdmin to administer PostGreSQL/PostGIS

For communication with the PostgreSQL/PostGIS system, you could use any
universal SQL client, but it is easiest to use the specific PostgreSQL client
called pgAdmin lIl:
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Task 1: Start the application “pgAdmin III” : there should be a shortcut to it in
the menu Geospatial > Databases > pgAdminIII.

In the list of servers, there should be one (localhost) already defined to con-
nect to. You can double-click that to open a connection to the PostgreSQL
server.

[If not present yet: Choose File > Add Server and fill in the dialog: the address
should be localhost, the port 5432 and you should specify the user name
“‘user” and password “user”.]

Now you can browse the databases and look at the tables, functions and other
objects they hold. There are already some databases that you can look at. But
what makes a database into a spatial database? For that the spatial function
and types of the PostGIS extension should be loaded.

This is best demonstrated when we create a spatial database:

Task 2: Create a new database by right-clicking the Databases icon and
choosing New database...

Name the DB test with uTr-8 as encoding and template postgis as tem-
plate: Using the template_postgis database ensures that the PostGIS spatial
datatypes and functions are loaded.

Open the database you just created, it should have one schema (public), with
two tables: ’'spatial_ref_sys’ and 'geometry_columns’. You can look at the
contents of any table by right-clicking them and selecting

View Data Of View data (top 100 rows).

Table spatial_ref_sys: This is the special PostGIS table that holds the EPSG
definitions of the spatial reference systems. Users can only read this table, and
the internal PostGIS functions use it for (re)projections and geometric calcula-
tions.

Table Geometry_columns: This is the special PostGIS table that will store the
metadata about the spatial data in the database: it holds information about
which tables hold geometries, in which column the geometry is stored, what
type that geometries is (polygon, point, line, etc.) and which spatial reference
systems they use. At the moment it is still empty, because we have no spatial
data in the database yet.

We can populate a database using the SQL commands in pgAdmin or running
command-line programs such as shp2pgsql, but we will use the QGIS desktop
GIS we used earlier to do that in the next section.
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K.2.1. Using SQL for communication with the database

You can execute queries on the DB using the SQL window:

Task 3: Open the database “natural_earth”. Now start the SQL query tool by
clicking the SQL icon in the toolbar or choosing the menu Tools > Query. In
the SQL editor pane, type the query:

SELECT * FROM "10m admin O countries™

Click the run (little triangle) icon to execute the SQL, or choose the menu
Query> Execute.

You'll see in the output that the column the geom of the table world is shown
as a long row of (hexadecimal) characters. This is because these are the geo-
metric data, stored in an internal binary format, which cannot be read by hu-
mans straight-away. But you can use the PostGIS SQL function
AsText (the geom) to show it in OGC WKT, which stands for “Well Know
Text”, a human-readable form of the OGC geometry:

Task 4: Try to find out how to get the geometry shown as OGC Well Know
Text in the output window. You should use the PostGIS function called

AsText (the geom)

K.3. Using PostGIS data in QGIS

In the earlier lesson where QuantumGlS, or QGIS was introduced, we already
explained that this Open Source desktop GIS can connect to spatially-enabled
PostgreSQL/PostGIS tables, by means of a “live” connection to the database
server.

K.3.1. Showing PostGIS data in QGIS layers

PostGIS data can be loaded into map layers. Below we will show you how to
load vector data from one of the available sets of test data in the OSGEO Live
system: Natural Earth.

Natural Earth is a dataset that provides cartographers an off-the shelf solution
for creating small-scale world, regional, and country maps at 1:10-, 1:50-, and
1:110millionscales. Both political (administrative) and physical (natural) fea-
tures are included and vector features align perfectly with included raster data.

Natural Earth solves the common problem that many cartographers face: find-
ing vector data for publication-quality small-scale maps at the appropriate level
of detail for the maps they are making. Its core features are that vector features
include name and other attributes, with built-in scale attributes to direct features
to be shown at different zoom levels; Large polygons are split for more efficient
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data handling; Lines contain enough data points for smooth bending in conic
projections, but not so many that computer processing speed suffers; Raster
data includes grayscale-shaded relief and cross-blended hypsometric tints.

Natural earth data is public domain, unlicensed and free to use for everyone.
Its available on the website http:/naturalearthdata.com

Task 5: Start QGIS. Click the “Add PostGIS Layers” icon or use the Layer >
Add PostGIS Layers... menu. From the pull-down menu Connection,
choose the “NaturalEarth” connection.

A list with available layers will appear. Click the Edit button to see details of
the connection. Notice that QGIS will try to connect to a database running on
the 1ocalhost host. Cancel the connection editor.

The PostGIS connection can be to any PostGreSQL server running on any
host, providing that QGIS can connect to this server over the internet or an in-
tranet, through the PostGreSQL database port (normally 5432). In this case the
server is running on your own computer within the OSGEO Live environment.

QGIS will only show tables that have spatial content, i.e. that have at least one
column of spatial data. We can now load any of these available tables:

Task 6: Select the first layer “10m_admin_0_countries” and click the add but-
ton. The map layer will be drawn. «
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Fig. K.1: PostGIS connections in QGIS.
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Initially all data from the table will be loaded and drawn. Essentially the QGIS
connection is used to do a SELECT * FROM "10m admin 0 countries" SQL
query. We can however change this behaviour:

Task 7: Select the layer in the Layers Panel and choose the menu Layer >
Query. .. (or right-click the layer name and choose gquery). A Query Builder
window will appear.

Try to make the layer show only those countries of which the name starts with
the letter “N”. Note that in SQL, text comparisons are done using the “LIKE”
keyword, and that the SQL wildcard character is the percentage sign %.

K.3.2. Loading data info PostGIS using QGIS

We can also use QGIS to load data into PostGIS tables. Any vector data we
have available as a QGIS layer can be saved as a Shapefile, and there is a
Shapefile to PostGIS Import Tool (SPIT) plugin. You will first have to activate
this plugin:

Task 8: Choose the Plugins > Manage Plugins... menu. Select the plugin
named “SPIT” and press ok. A new menu item Database > Spit will be
available.

Now you can use the plugin to load one or more shape files into a database.
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Fig. K.2: QGIS Extension Manager.
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Task 9: Choose the Database > spit menu. The SPIT dialog will appear.

First you have to specify the connection to the database. In most cases you
might want to first create a new database yourself (using a DB administration
software such as pgAdmin), but for now we will use the existing Natu-
ralEarth connection again: Select it and click connect.

Now use the add button to browse for a shape file. You can use the data you
created in the earlier QGIS exercise (where you digitized a route on a Open-
StreetMap background), or try to find another useful shape-file in the OSGEO
Live system or on your own hard disk.

Now click the ok button, and the plugin will load the data into the appropriate
database tables. You can test this by trying to load the new table as a map
layer.
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Fig. K.3: SPIT, Shape file to PostGIS import tool.
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L. PostGreSQL/PostGIS Spatial Databases:
Using PostGIS Data in a MapServer WMS

Version 2.3 - September 18, 2012

L.1. Principles of using PostGIS in MapServer
L.2. Further Layer definitions
L.3. A challenge: Trying a more complicated query

Key points

In this small exercise you will use PostGIS data in Mapserver. It is not a step—
by-step exercise, but only a quick overview of some of the necessary setups.
This exercise assumes you have already done the exercise “Serving data as
a Web Map Services using MapServer’, as well as PostgreSQL/PostGIS
basics!

This exercise also assumes you are working with the OSGEO LIVE system.

1T ©ITC—University of Twente, Faculty of Geo—Information Science and Earth Observation. This docu-
ment may be freely reproduced for educational use. It may not be edited or translated without the consent of the
copyright holder.
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L.1. Principles of using postGIS in MapServer

When using shape—files, connecting a LAYER to a datasource was a simple
matter of specifying the DATA parameter as a path to a file. For connections to
a PostGIS datasource, you have to use the more elaborate CONNECTION pa-
rameter with a CONNECTIONTYPE postgis. The general form of the connec-
tion parameters is:

CONNECTIONTYPE postgis

CONNECTION "user=<username> password=<password> dbname=<database>
— host=<dbhost> port=<port> options='-cclient encoding=
—<encoding>'"

DATA "<geometry column> FROM <table> USING unique <PK>

—USING srid=<srid>"

In the CONNECTION parameter, you fill in the correct username, password,
etcetera. The <encoding> should match the encoding of the PostGIS database,
normally this would be UTF8. In the DATA parameter, you specify a special
type of SQL statement that will be sent to the PostGIS database. The <PK>
should be the name of a column in your table that is unique for all rows, usually
the Primary Key column.

For example: You want to get the countries of the world geometry out of the
database of Natural Earth data pre—installed in PostGIS on the OSGEO LIVE
system (in the table 10m_admin_0_countries of the database natural_earth on
the localhost database server). Then you should type:

CONNECTIONTYPE postgis

CONNECTION "user=user password=user dbname=natural earth

— host=localhost port=5432 options=’'-c client encoding=UTF8'"
DATA "the geom FROM 10m admin O countries

— USING UNIQUE gid USING srid=4326"

The nice thing is, that the DATA string is basically an SQL select string; there-
fore, you can change it to any valid SQL statement that makes a more complex
query. An example of retrieving only countries with a name starting with A
would be:

DATA "the geom FROM (SELECT * FROM 10m admin O countries WHERE
— cntry name LIKE 'A%') AS foo USING UNIQUE gid USING srid=4326"
Note that the MapServer SQL parser is a bit peculiar: It needs its query always
to result in only a geometry column: this is achieved by making a sub—query
with an alias (hence the AS foo statement).

L.2. Further Layer definitions

For correct use of PostGIS layers in many of the GIS clients, MapServer needs
a full specification of the LAYERS extent in the metadata of the layer. In order
to do that, in the METADATA object in the LAYER, add the line "ows_extent”
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"xmin ymin xmax ymax" You can usually just copy the extent string from the
general MAP extent. When using the world database countries data, for exam-
ple, the relevant part of your LAYER would look like:

CONNECTIONTYPE postgis

CONNECTION "user=user password=user dbname=natural earth

— host=localhost port=5432 options=’'-c client encoding=UTF8'"
DATA "the geom FROM 10m admin O countries

— USING UNIQUE gid USING srid=4326"

METADATA
"ows title" "world"
"ows_extent” "-180 -90 180 90"
END

Task 1: Now set up MapServer to show a map of the countries in the world
from the world PostGIS database described above).

You’'ll have to set up an appropriate LAYER in a *.map file first. You can then
show the layer using a GetMap request typed in a browser URL, or even
nicer: request it in an OpenlLayers html page...!

L.3. A challenge: Trying a more complicated query

If you have time and at least a bit of SQL knowledge, you should try this more
challenging query:

Task 2 : The challenge is to set up Mapserver to show a map of the countries
in the world that only shows the countries where the distance to ITC’s location
(measured on the WGS84 ellipsoid) is less then 2000 km. «

The pieces you can use for this puzzle are:

¢ |TC’s location in lon/latis: 6.8862 , 52.2237;

» There is a PostGIS function geometryFromText (0GC_WKT, srid) to make a
geometry from an OGC Well-Known Text string (WKTs are explained in the
PostGIS manual and on the OGC standards webpages);

» there is another function ST Centroid(geometry) that returns the centroid
of any geometry, as a point;

» and yet another function ST Distance sphere (point,point) that calcu-
lates the distance in meters between two points, as a great circle (projected
on the WGS84 datum in lon/lat).

If you need additional information, use the PostGIS manual.
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